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1.1  Microsoft Windows XP/2003 
 
What is an operating system and basic of windows? 
 
The operating system (OS) is the first thing loaded onto the computer, without the 
operating system, a computer is useless. The purpose of an operating system is to 
organize and control hardware and software so that the device it lives in behaves in a 
flexible but predictable way. The operating system is a interface between user and 
computer. Computer software can be divided into two main categories: 
 
Application software and system software.  

Application software consists of the programs for performing tasks particular to the 
machine's utilization. Examples of application software include spreadsheets, 
database systems, desktop publishing systems, program development software, and 
games." Application software is generally what we think of when someone speaks of 
computer programs. This software is designed to solve a particular problem for users. 
The diagram below illustrates the relationship between application software and 
system software.  

 

On the other hand, system software is more transparent and less noticed by the typical 
computer user. This software “provides a general programming environment in which 
programmers can create specific applications to suit their needs. This environment 
provides new functions that are not available at the hardware level and performs tasks 
related to executing the application program”. System software acts as an interface 
between the hardware of the computer and the application software that users need to 
run on the computer. 
  
An operating system has three main responsibilities: 
1. Perform basic tasks, such as recognizing input from the keyboard, sending 
 output to the display screen, keeping track of files and directories on the 
 disk, and controlling peripheral devices such as disk drives and printers. 
2. Ensure that different programs and users running at the same time do not 
 interfere with each other. 
 
3. Provide a software platform on top of which other programs (i.e.,  application  

software) can run.  
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The most operating system in India is Microsoft’s Windows operating system. 
Among these Windows 98 and Windows XP are the most used operating system in 
PC(Personal Computer). Microsoft Windows 2000 and Microsoft Windows 2003 are 
the network operating system which is used in the network. 
 
Other operating systems are UNIX, LINUX, OS/2 are also widely used and accepted.  
Windows XP is the name of a line of operating systems developed by Microsoft for 
use on general-purpose computer systems, including home and business desktops, 
notebook computers, and media centers. The letters "XP" stand for experience.[1] 
Codenamed Whistler during its development, Windows XP is the successor to both 
Windows 2000 and Windows Me, and is the first consumer-oriented operating system 
produced by Microsoft to be built on the Windows NT kernel and architecture. With 
the release of Windows XP the Windows 95/98 architecture was finally discontinued. 
Windows XP was first released on October 25, 2001, and as of 2006 continues to be 
the most recent consumer version of Microsoft Windows available, with over 400 
million copies in use.  
 
The most common editions of the operating system are Windows XP Home Edition, 
which is targeted at home users, and Windows XP Professional, which has additional 
features such as support for Windows Server domains and dual processors, and is 
targeted at power users and business clients. Windows XP Media Center Edition 
consists of Windows XP Professional with new features enhancing the ability to 
record and watch TV shows, watch DVDs, listen to music and more. Windows XP 
Tablet PC Edition is designed to run the ink-aware Tablet PC platform. Two separate 
64-bit versions of Windows XP were also released, Windows XP 64-bit Edition for 
IA-64 (Itanium) processors and Windows XP Professional x64 Edition for 
AMD64/EM64T processors. 
 
Windows XP is known for its improved stability and efficiency over previous 
versions of Windows. It presents a significantly redesigned graphical user interface 
(GUI), a change Microsoft promoted as more user-friendly than previous versions of 
Windows. New software management capabilities were introduced to avoid the "DLL 
hell" that plagued older consumer versions of Windows. It is also the first version of 
Windows to use product activation to combat software piracy, a restriction that did 
not sit well with some users and privacy advocates. Windows XP has also been 
criticized by some users for security vulnerabilities, tight integration of applications 
such as Internet Explorer and Windows Media Player, and for aspects of its user 
interface. 
 
Windows Vista is scheduled to be the next major revision of Microsoft Windows, 
with a planned release date of November 2006 for business editions, and January 
2007 for other editions. 

Booting Up the computer 

In computing, booting is a bootstrapping process that starts operating systems when 
the user turns on a computer system. A boot sequence is the set of operations the 
computer performs when it is switched on which load an operating system. 
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http://en.wikipedia.org/wiki/Windows_XP_Tablet_PC_Edition
http://en.wikipedia.org/wiki/Windows_XP_Tablet_PC_Edition
http://en.wikipedia.org/wiki/Tablet_PC
http://en.wikipedia.org/wiki/64-bit
http://en.wikipedia.org/wiki/Windows_XP_64-bit_Edition
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Different Versions of Windows  

The version of Windows installed on your new PC is probably Windows XP. 
Microsoft has released different versions of Windows over the years, and XP is the 
latest—which is why it comes preinstalled on most new PCs. 

If you’ve used a previous version of Windows—such as Windows 95, Windows 98, 
or Windows Me—on another PC, Windows XP probably looks and acts a little 
different from what you’re used to. Don’t worry; everything that was in the old 
Windows is still in the new Windows—it’s probably just in a slightly different place. 

There are actually two different retail versions of Windows XP. Windows XP Home 
Edition, which comes with most lower-priced PCs, is the version of XP for home and 
small-business users. Windows XP Professional Edition, which comes with some 
higher-priced PCs, is designed for larger businesses and corporate users. They both 
share the same basic functionality; XP Professional just has a few more features 
specifically designed for large corporate networks. 

In addition, some new "media center" PCs come with a slightly different version of 
Windows XP called Windows XP Media Center Edition. The Media Center is an 
optional interface that sits on the top of the normal Windows XP desktop and allows 
one-button access to key multimedia functions, including My TV, My Music, My 
Pictures, and My Videos. In fact, PCs equipped with Media Center come with a 
handheld remote control for quick switching from across the room! If you have 
Windows XP Media Center, don’t panic; underneath the Media Center is the same 
Windows XP we all know and love, and that is described in this chapter. 

1.2 Introduction about Desktop, Mouse and Keyboard 
 
Desktop 

As you can see in the following figure,  the Windows XP desktop includes a number 
of elements. Get to know the desktop; you’re going to be seeing a lot of it from now 
on. 
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The Windows XP desktop 

The major parts of the Windows desktop include 

• Start button  - Opens the Start menu, which is what you can use to open  all your 
programs and documents. 

• Taskbar - Displays buttons for your open applications and windows, as well as 
different toolbars for different tasks. 

• System Tray - The part of the taskbar that holds the clock, volume control, and 
icons for other utilities that run in the background of your system. 

• Shortcut icons - These are links to software programs you can place on your 
desktop; a "clean" desktop includes just one icon, for the Windows Recycle Bin. 

• Recycle Bin - This is where you dump any files you want to delete. 

Introduction about Keyboard 
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Key Function 

F1- F12 (Function keys) Used to perform special functions that depend on the software being 
used. 

Enter or Return  Used to execute an instruction or data being keyed in through the
keyboard 

Caps lock Used for keying in capitalized alphabets. 

Shift Capslock off: If pressed simultaneously with a character key, a 
capitalized alphabet is input Capslock on: It reverses the above effect. 
Also used to input the upper symbols for keys with two symbols or 
characters on them. 

Alt key Pressed with other keys, they input special messages to the computer. 

Backspace Used to erase the character to the left of the cursor position. 

NumLock Used to activate the numeric keys on the Numeric keypad. 

Cursor keys Used to move the cursor in the direction indicated. 

Home, End, PgUp, PgDn Used to perform special functions, with which you will become 
familiar during the course. 

Ins Used to insert characters at the current cursor position 

Del Used to delete characters at the current cursor position. 

Esc Depends on the application. Usually used to cancel a command. 

Print Screen Used to print whatever is displayed on the screen. 

SysRq System Required; depends on the application. 

 
Introduction about Mouse 
 
A mouse is a small device that is connected to the system unit by  means of a long 
wire. This is another input device, whose movement causes the corresponding 
movement of a pointer on the screen. It usually has two or three buttons using which 
the user can select options from the screen. 
 
Important Windows Operations 
 
To use Windows efficiently, you must master a few simple operations, such as 
pointing and clicking, dragging and dropping, and right-clicking. You perform all 
these operations with your mouse. 

Pointing and Clicking 

The most common mouse operation is pointing and clicking. Simply move the mouse 
so that the cursor is pointing to the object you want to select, and then click the left 
mouse button once. Pointing and clicking is an effective way to select menu items, 
directories, and files. 
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Double-Clicking 

If you’re using Windows XP’s default operating mode, you’ll need to double-click an 
item to activate an operation. This involves pointing at something onscreen with the 
cursor and then clicking the left mouse button twice in rapid succession. For example, 
to open program groups or launch individual programs, simply double-click a specific 
icon. 

Right-Clicking 

When you select an item and then click the right mouse button, you’ll often see a 
pop-up menu. This menu, when available, contains commands that directly relate to 
the selected object. Refer to your individual programs to see whether and how they 
use the right mouse button. 

Dragging and Dropping 

Dragging is a variation of clicking. To drag an object, point at it with the cursor and 
then press and hold down the left mouse button. Move the mouse without releasing 
the mouse button, and drag the object to a new location. When you’re done moving 
the object, release the mouse button to drop it onto the new location. 

You can use dragging and dropping to move files from one folder to another or to 
delete files by dragging them onto the Recycle Bin icon. 

Hovering 

When you position the cursor over an item without clicking your mouse, you’re 
hovering over that item. Many operations require you to hover your cursor and then 
perform some other action. 

Moving and Resizing Windows 

Every software program you launch is displayed in a separate onscreen window. 
When you open more than one program, you get more than one window—and your 
desktop can quickly get cluttered. 

There are many ways to deal with desktop clutter. One way to do this is to move a 
window to a new position. You do this by positioning your cursor over the window’s 
title bar and then clicking and holding down the left button on your mouse. As long as 
this button is depressed, you can use your mouse to drag the window around the 
screen. When you release the mouse button, the window stays where you put it. 

You also can change the size of most windows. You do this by positioning the cursor 
over the very edge of the window—any edge. If you position the cursor on either side 
of the window, you can resize the width. If you position the cursor on the top or 
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bottom edge, you can resize the height. Finally, if you position the cursor on a corner, 
you can resize the width and height at the same time. 
 
Maximizing, Minimizing, and Closing Windows 
 
Another way to manage a window in Windows is to make it display full-screen. You 
do this by maximizing the window. All you have to do is click the Maximize button 
at the upper-right corner of the window, as shown in following Figure  
 

 
 
 
 
 
 
 

 

If the window is already maximized, the Maximize button changes to a Restore Down 
button. When you click the Restore Down button, the window resumes its previous 
(pre-maximized) dimensions. 

If you would rather hide the window so that it doesn’t clutter your desktop, click the 
Minimize button. This shoves the window off the desktop, onto the Taskbar. The 
program in the window is still running, however—it’s just not on the desktop. To 
restore a minimized window, all you have to do is click the window’s button on the 
Windows Taskbar (at the bottom of the screen). 

Caution 

If you try to close a window that contains a document you haven’t saved, you’ll be 
prompted to save the changes to the document. Because you probably don’t want to 
lose any of your work, click Yes to save the document and then close the program. 

If what you really want to do is close the window (and close any program running 
within the window), just click the window’s Close button. 

Scrolling Through a Window 

Many windows contain more information than can be displayed at once. When you 
have a long document or web page, only the first part of the document or page is 
displayed in the window. To view the rest of the document or page, you have to scroll 
down through the window, using the various parts of the scroll bar (As shown in the 
following Figure). 

CLOSE BUTTON

MINIMISE BUTTON

RESTORE BUTTON
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There are several ways to scroll through a window. To scroll up or down a line at a 
time, click the up or down arrow on the window’s scrollbar. To move to a specific 
place in a long document, use your mouse to grab the scroll box (between the up and 
down arrows) and drag it to a new position. You can also click on the scroll bar 
between the scroll box and the end arrow, which scrolls you one screen at a time. 

If your mouse has a scroll wheel, you can use it to scroll through a long document. 
Just roll the wheel back or forward to scroll down or up through a window. 

Using Menus 

Most windows in Windows use a set of pull-down menus to store all the commands 
and operations you can perform. The menus are aligned across the top of the window, 
just below the title bar, in what is called a menu bar.  

 

You open (or pull down) a menu by clicking the menu’s name. The full menu then 
appears just below the menu bar, as shown in Figure below. You activate a command 
or select a menu item by clicking it with your mouse.  

 

Some menu items have a little black arrow to the right of the label. This indicates that 
additional choices are available, displayed on a submenu. Click the menu item or the 
arrow to display the submenu. 

Other menu items have three little dots (called an ellipsis) to the right of the label. 
This indicates that additional choices are available, displayed in a dialog box. Click 
the menu item to display the dialog box. 
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Using Toolbars 

Some Windows programs put the most frequently used operations on one or more 
toolbars, typically located just below the menu bar. A toolbar looks like a row of 
buttons, each with a small picture (called an icon) and maybe a bit of text. You 
activate the associated command or operation by clicking the button with your mouse. 

If the toolbar is too long to display fully on your screen, you’ll see a right arrow at the 
far-right side of the toolbar. Click this arrow to display the buttons that aren’t 
currently visible. 

Tool tip 

If you’re not sure which button does what, you can hover the cursor over the button to 
display a tool tip. A tool tip is a small text box that displays the button’s label or other 
useful information. 

Using Dialog Boxes, Tabs, and Buttons 

When Windows or an application requires a complex set of inputs, you are often 
presented with a dialog box. A dialog box is similar to a form in which you can input 
various parameters and make various choices—and then register those inputs and 
choices when you click the OK button. (Figure shows the Print dialog box, found in 
most Windows applications.) 

 
Use dialog boxes to control various aspects of your Windows applications. 

There are several different types of dialog boxes, each one customized to the task at 
hand. However, most dialog boxes share a set of common features, which include the 
following: 
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• Buttons—Most buttons either register your inputs or open an auxiliary dialog 
box. The most common buttons are OK (to register your inputs and close the 
dialog box), Cancel (to close the dialog box without registering your inputs), and 
Apply (to register your inputs without closing the dialog box).  

• Tabs—These allow a single dialog box to display multiple "pages" of 
information. Think of each tab, arranged across the top of the dialog box, as a 
"thumb tab" to the individual page in the dialog box below it. Click the top of a 
tab to change to that particular page of information. 

• Text boxes—These are empty boxes where you type in a response. Position your 
cursor over the empty input box, click your left mouse button, and begin typing. 

• Lists—These are lists of available choices; lists can either scroll or drop down 
from what looks like an input box. Select an item from the list with your mouse; 
you can select multiple items in some lists by holding down the Ctrl key while 
clicking with your mouse. 

• Check boxes—These are boxes that let you select (or deselect) various 
standalone options. 

• Sliders—These are sliding bars that let you select increments between two 
extremes, similar to a sliding volume control on an audio system. 

Using the Start Menu 

All the software programs and utilities on your computer are accessed via Windows’ 
Start menu. You display the Start menu by using your mouse to click the Start button, 
located in the lower-left corner of your screen. 

As you can see in Figure , the Windows XP Start menu consists of two columns of 
icons. Your most frequently used programs are listed in the left column; basic 
Windows utilities and folders are listed in the right column. To open a specific 
program or folder, just click the icon. 

 
Access all the programs on your system from the Start menu. 
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To view the rest of your programs, click the All Programs arrow. This displays a new 
menu called the Programs menu. From here you can access various programs, sorted 
by type or manufacturer. (When more programs are contained within a master folder, 
you’ll see an arrow to the right of the title; click this arrow to display additional 
choices.) 

Launching a Program 

Now that you know how to work the Start menu, it’s easy to start any particular 
software program. All you have to do is follow these steps: 

1. Click the Start button to display the Start menu. 
2. If the program is displayed on the Start menu, click the program’s icon. 
3. If the program isn’t visible on the main Start menu, click the All Programs button, 

find the program’s icon, and then click it. 

Switching Between Programs 
After you’ve launched a few programs, it’s easy to switch between one program and 
another. To switch to another program (and send all other open programs to the 
background), you can do one of the following: 
• Click the application’s button in the taskbar 
To switch between applications. 
• Click any visible part of the application’s window—including its title bar. 
• Hold down the Alt key and then press the Tab key repeatedly until the application 

window you want is selected. (This cycles through all open windows.) When 
you’re at the window you want, release the Alt key. 

If you have multiple windows open at the same time, you can determine which is 
currently the active window by its title bar. The title bar for the active program is 
brighter, and the title bar text is bright white. An inactive title bar is more dull, with 
off-white text. If you have overlapping windows on your desktop, the window on top 
is always the active one. The active application’s Taskbar button looks like it’s 
pressed in. 

Shutting Down Windows—and Your Computer 

Windows starts automatically every time you turn on your computer. Although you 
will see lines of text flashing onscreen during the initial startup, Windows loads 
automatically and goes on to display the Windows desktop. 

Do not turn off your computer without shutting down Windows. You could lose data 
and settings that are temporarily stored in your system’s memory. 

To shut down Windows and turn off your PC, follow these steps: 

1. Click the Start button to display the Start menu. 
2. Click the Turn off Computer button. 
3. When the Turn off Computer dialog box appears, click the Turn Off button. 
4. Manually turn off your monitor, printer, and other peripherals. 
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1.3  File and Folder Management 

All the information on your computer is stored in files. A file is nothing more than a 
collection of data of some sort. Everything on your computer’s hard drive is a 
separate file, with its own name, location, and properties. The contents of a file can be 
a document from an application (such as a Works worksheet or a Word document), or 
they can be the executable code for the application itself. 

Every file has its own unique name. A defined structure exists for naming files, and 
its conventions must be followed for Windows to understand exactly what file you 
want when you try to access one. Each filename must consist of two parts, separated 
by a period—the name (to the left of the period) and the extension (to the right of the 
period). A filename can consist of letters, numbers, spaces, and characters and looks 
something like this: this is a filename.ext. 

Windows stores files in folders. A folder is like a master file; each folder can contain 
both files and additional folders. The exact location of a file is called its path and 
contains all the folders leading to the file. For example, a file named filename.doc 
that exists in the system folder, that is itself contained in the windows folder on your 
c:\ drive, has a path that looks like this: c:\windows\system\filename.doc. 

Managing PC Resources with My Computer 

The My Computer utility lets you access each major component of your system and 
perform basic maintenance functions. For example, you can use My Computer to 
"open" the contents of your hard disk, and then copy, move, and delete individual 
files. 

To open My Computer, follow these steps: 
1. Click the Start button to display the Start menu. 
2. Select My Computer. 

As you can see in the following Figure , the My Computer folder contains icons for 
each of the major components of your system—your hard disk drive, floppy disk 
drive, CD-ROM or DVD drive, and so on. 
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Use My Computer to manage your hard drive and other key components. 

Each folder in Windows XP contains an activity pane (sometimes called a task pane) 
on the left side of the window. This pane lets you view relevant information about 
and perform key operations on the selected item. 

You can also use My Computer to view the contents of a specific drive. When you 
double-click the icon for that drive, you’ll see a list of folders and files located on that 
drive. To view the contents of any folder, just double-click the icon for that folder. 

Managing Files with My Documents 

The documents you create with Microsoft Word and other software programs are 
actually separate computer files. By default, all your documents are stored 
somewhere in the My Documents folder. 

Windows lets you access the contents of your My Documents folder with a few clicks 
of your mouse. Just follow these steps: 

1. Click the Start button to display the Start menu. 
2. Click My Documents. 

As you can see in the following Figure, the My Documents folder not only contains 
individual files, it also contains a number of other folders (sometimes called 
subfolders), such as My Pictures and My Music. Double-click a subfolder to view its 
contents, or use the options in the Files and Folders Tasks panel to perform specific 
operations—including moving, copying, and deleting. 
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Access your important document files from the My Documents folder. 

Managing Windows with the Control Panel 

There’s one more Windows utility, similar to My Computer and My Documents that 
you need to know about. This utility, the Control Panel, is used to manage most (but 
not all) of Windows’ configuration settings. The Control Panel is actually a system 
folder (like My Computer and My Documents) that contains a number of individual 
utilities that let you adjust and configure various system properties. 

To open the Control Panel, follow these steps: 

1. Click the Start button to display the Start menu. 
2. Click Control Panel. 

When the Control Panel opens, as shown in the following Figure, you can select a 
particular category you want to configure. When the Pick a Task page appears, either 
click a task or click an icon to open a specific configuration utility. (When you click a 
task, the appropriate configuration utility is launched.) 
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The Windows XP Control Panel—configuration tasks organized by category. 

When you open a configuration utility, you’ll see a dialog box for that particular item. 
You can then change the individual settings within that dialog box; click the OK 
button to register your new settings. 

All the Other Things in Windows 

Windows is more than just a pretty desktop and some configuration utilities. 
Windows also includes a large number of accessory programs and system tools you 
can use to perform other basic system operations. 

Accessories 

Windows includes a number of single-function accessory programs, all accessible 
from the Start menu. These programs include a calculator, some games, two basic 
word processors (Notepad and WordPad), a drawing program (Paint), a player for 
audio and video files (Windows Media Player), and a digital video editing program 
(Windows Movie Maker). You access most of these accessories by clicking the Start 
button and selecting All Programs, Accessories. 

Internet Utilities 

In addition to the aforementioned Windows accessories, Windows XP also gives you 
three important Internet utilities. These include a web browser (Internet Explorer), an 
email program (Outlook Express), and an instant messaging program (Windows 
Messenger). You access these three utilities by clicking the Start button and selecting 
All Programs. 
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System Tools 

Windows XP includes a handful of technical tools you can use to keep your system 
running smoothly. You can access all these tools by clicking the Start button and 
selecting All Programs, Accessories, and System Tools. 
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Windows Server 2003 

Windows Server 2003 is the name of Microsoft's line of server operating systems. It 
was introduced in April 2003 as the successor to Windows 2000 Server, and is 
considered by Microsoft to be the cornerstone of their Windows Server System line 
of business server products. 

Overview 

Released on April 24, 2003, Windows Server 2003 (which carries the version number 
5.2) is the follow-up to Windows 2000 Server, incorporating compatibility and other 
features from Windows XP. Unlike Windows 2000 Server, Windows Server 2003's 
default installation has none of the server components enabled, to reduce the attack 
surface of new machines. Windows Server 2003 includes compatibility modes to 
allow older applications to run with greater stability. It was made more compatible 
with Windows NT 4.0 domain-based networking. Incorporating and upgrading a 
Windows NT 4.0 domain to Windows 2000 was considered difficult and time 
consuming, and generally was considered an all or nothing upgrade particularly when 
dealing with Active Directory. Windows Server 2003 brought in enhanced Active 
Directory compatibility, and better deployment support, to ease the transition from 
Windows NT 4.0 to Windows Server 2003 and Windows XP Professional. 

Significant enhancements have been made to various services such as the IIS web 
server (which was almost completely re-written to improve performance and 
security), Distributed File System (which now supports hosting multiple DFS roots on 
a single server), Terminal Server, Active Directory, Print Server, and a number of 
other areas. Windows Server 2003 was also the first operating system released by 
Microsoft after the announcement of their Trustworthy Computing initiative, and as a 
result, contains a number of improvements to security defaults and practices. 

The product went through several name changes during the course of development. 
When first introduced to technical beta testers in mid-2000, it was known by its 
codename, "Whistler Server"; it then changed to "Windows 2002 Server" for a brief 
time in mid-2001, before being renamed "Windows .NET Server" as part of 
Microsoft's effort to promote their new integrated enterprise and development 
framework, Microsoft .NET. However, due to fears of confusing the market about 
what ".NET" represents and responding to criticism, Microsoft removed .NET from 
the name during the Release Candidate stage in late 2002. This allowed the name 
.NET to exclusively apply to the .NET Framework, as previously it had appeared that 
.NET was just a tag for a generation of Microsoft products. 
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1.4 MS Word 2003 including Advanced features 
 

Opening Word Processing Package. 
 

  The steps to activate Word are: 
• Click on the Start button in the taskbar. 
• Select the Programs option from the Start menu. 
• Click on the Microsoft Word option (refer Figure 1.1). 
 
This invokes MS Word and displays a document window. 

 

 
 

A new document window is displayed each time Microsoft Word is invoked: 
 

 
 

 
  The Menu Bar 

 
Menu bar—is positioned below the Title bar. It contains options like  
• File 
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•  Edit 
•  View 
• Format 
 
Each of these menu bar items has drop-down menus. A drop-down menu comprises a 
list of options which drops down when you click on the menu bar item. The options 
can be activated by pressing together the Alt key and the underlined character in the 
option name (often called hot keys). For example, the user can press Alt and f keys 
together to invoke the File menu. etc. 

 
      Using the Icons below menu bar – Toolbar 
 

Toolbar— helps the user to perform tasks faster and with ease. Two of the most 
commonly-used toolbars are the standard toolbar and the formatting toolbar. The 
standard toolbar provides shortcuts for menu commands while the formatting toolbar 
contains tools related to formatting of the text in the document. When the user starts 
MS Word, these toolbars are displayed just below the menu bar. 

 
 Opening documents, Save and Save As 

 
Word allows you to create and save a document on the disk. 
The steps to create a new document are: 
1.    Select the New option from the File menu. 
2. Select the Blank Document icon.  
3. Click on the Document radio button in the Create New box. 
 
To create a new template, click on the Template radio button in the Create New box. 
4. Click on the OK button. 
 
A blank new document is displayed. 
 
Opening a Document 
The steps to open an existing document are:  
1.   Select the Open option from the File menu or press Ctrl + O. 
      An Open dialog box is displayed as shown in Figure. 
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2. Select the appropriate drive and folder. 
3. Type the name of the file to be opened in the File Name text box or select the file 

from the list. 
4. Click on the Open button. 

 
 Saving a Document 

 
When a document is typed, it is stored in the internal memory of the machine. In 
order to preserve the document for future use, it needs to be saved on the disk.  
The steps to save a document are:  
1. Select the Save As option from the File Menu. 
The Save As dialog box is displayed as shown in the following figure: 
 

 
 
2. Type a file name in the File Name box. 
3. Click on the Save button. 
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By default, the new document is saved as a word document with an extension .doc. If 
we want to save as different type we have to click save as type as show below: 
 

 
 
4. Once a document is saved with a specific name, save button from File menu is  

used to save the document while editing. 
 
If we want to set different tools from Save As dialog box, 
 

 
 

File -> Save As -> Tools 
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For security options, click on security options in tools. 
 

 
 
 

 Page Setup, Print View, Printing of documents, Print a selected page 
 

Page Setup 
This command is used to change paper source, paper size, margins and page 
orientation for the document. 

 
Select a paper source 
1. On the File menu, click Page Setup. 
Following dialog box will appear. 
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2. Click on Paper Tab. 
3. Select the Paper source from the List box. 
 
Select a paper size 
1. On the File menu, click Page Setup. 
2. Click on Paper Tab. 
3.  Select the Paper size from the drop down list box. 
 
Change page margins 
1. On the File menu, click Page Setup, and then click the Margins tab. 
 

 
 
2. Under Margins, select the options you want.  
 
Print View 
1.   Select the Print Preview Icon from the Standard Tool bar OR  
2.  Select the Print Preview from the File Menu  
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Printing of Document 
 
1. On the File menu,  select the Print option, Print dialog box will appear as shown 

in the following figure. 
 

 
 

2. Select the name of printer from the Printer Name box. 
3. Enter the no. of copies to print in the Number of copies box. 
4. Click on Ok to Print the document. 
 
Print a selected page 
 
1. Put a cursor on the page which is to print. 
2. Click on Print from the File menu. 
3. Click on  Current page radio button from the page range. 
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4. Click on Ok to print the selected page. 
 
 Display / Hiding of Paragraph Marks and Inter Word Space 
 

1. Click on Tools from Menu bar. 
 
2. Select Options from the Tools. An Option dialog box will appear as shown in 

the following figure. 
 

 
 

3. Select View tab from the dialog  box. 
 
4. Mark / Unmark on Paragraph marks, spaces from formatting marks. 

 
5. If we want to set saving options click save dialog box. 
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Moving around in a Document, Scrolling the Document 
 

Following Table lists the various keys and key combinations used to move around in 
a document. 

 
Name of Keys(s) Moves the Cursor to 

Up arrow, Down arrow. Left 
arrow, Right arrow 

One character up, down, left and 
right. 

Ctrl + Right arrow Next word. 

Ctrl + Left arrow Previous word. 

Home Beginning of the line. 

End End of the line. 

Ctrl + Home Beginning of the document. 

Ctrt+End End of the document. 

Ctrl + Page up Beginning of previous page 

Ctrl + Page down Beginning of next page. 
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 Scrolling by line / paragraph, Fast Scrolling & Moving pages 
 

1. Page Up and Page Down keys are used to scroll one page up / down in a 
document. 

 
2. Moving a Vertical Scroll bar from the right side of word screen moves page up 

and down. 
 

3. Moving the horizontal scroll bar from the down side of word screen moves page 
left and right. 

 
 Paragraph and Tab Setting, Text selection, Cut, copy & paste 

 
Formatting Paragraphs 
In Word, each time you press the Enter key, you create a new paragraph. Word 
paragraphs always end with a paragraph mark. The paragraph mark is normally 
hidden from view, but stores all the paragraph formatting for the paragraph that it 
ends. 
 
Line Spacing 
Spacing is used to design a document and make it more readable. It is measured by 
lines. The default spacing is single. Word enables you to change the line spacing in 
your text. You can set spacing to single, double or one and half lines. 
 
The steps to set line spacing are: 
1.  Select the paragraph(s) to space. 
2.  Select the Paragraph option from the Format menu. 
 
The Paragraph dialog box is displayed as follows: 

 

 
 

3.  Select the Indents and Spacing tab. 
4.  Select an option from the Line Spacing drop-down list. 
5.  Select a value from the at list box. 
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6.  Click on the OK button to close the dialog box. 
 

Paragraph Spacing 
You can define the amount of white space that should be placed before and after 
paragraphs by using the Paragraph dialog box. 
 
The steps to add a single line of white space before or after a paragraph are:  
1.   Select the paragraph(s). 

 
2.   Open the Paragraph dialog box. 
3.   Select the Indents and Spacing tab. 
4.   Enter the specification in the before or After Spacing spin box  
5.   Click on the OK button. 
 
Setting Tabs 
Tabs are used for creating quick, relatively simple lists. Working with tabs is a two-part 
process. The first step is to set the tab stops. Word offers five types of tab stops—Left, 
Center, Right, Decimal and Bar tabs. The default tab stop is left. The second step in using 
tabs is to press the Tab key as the document is typed, to move the insertion point forward 
to the next tab stop. The default tab-stop position is 0.5 inch. 
 
Setting Tab Stops 
The Tab dialog box provides additional tab-related features. Word also provides tab 
leaders that make text easy to read. A tab leader is a row of dots or dashes that is inserted 
between two text elements. 
 
The steps to set tabs stops using the Tabs dialog box are: 
1.  Select the paragraph. 
2.   Select the Tabs option from the Format menu. 
 
The Tabs dialog box is displayed as follows: 
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3.   Using decimal numbers, type the position of the tab stop in the Tab Stop 
 Position box. 

4.   Select the tab alignment you want: Left, Center, Right, Decimal, or Bar from  the 
Alignment group. 

5.  Select the tab leader style you want: 1 for no leader, 2 for a dotted leader, 3  for 
a dashed leader, or 4 for an underlined leader from the Leader group. 

6.  Click on the Set button to set the tab stop. 
7. Click on the OK button. 

 
To clear the Tab setting, use the Clear button on the Tabs dialog box to clear the tabs. 

 
Indenting Text 
Indenting is making your text look more eye-catching. Indents are added to margins, 
thereby increasing the white space and decreasing the text area for specific 
paragraphs. 
 
You can indent your text by using the: 
• Ruler 
• Paragraph dialog box 

 
Using the Ruler 
The steps to set the left and right indents with the ruler bar are: 
1.   Select the paragraph(s) for which you want to set tabs. 
2.   Point to and then drag the appropriate triangular indent markers to the  

desired locations. 
 
When you release the mouse button, the text will be indented according to the 
specification.  
 
Using the Paragraph Dialog Box 
Using the Paragraph dialog box, you can specify the left, right, first line and hanging 
indents. 
 
The steps to set indents for text by using the paragraph dialog box are: 
1.   Select paragraph(s) to be indented. 
2.   Select the Paragraph option of the Format menu. 
 
The Paragraph dialog box is displayed. 
3.   Enter the specifications in the Left or Right Indentation spin box. 
 
You can also select First Line or Hanging indent from the Special drop-down list box. 
4.   Select a value in the by spin box. 
5.   Click on the OK button. 
 

 Text Selection 
When you enter your text, you are quite likely to make mistakes. Corrections of these 
mistakes are called editing. Editing text is an essential feature of a word processing 
package. 
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In order to perform any editing operation on the text in a document, the text needs to 
be selected. 
 
The steps to select a text are: 
1.   Position the insertion point at the beginning of the text to be selected. 
2.   Hold down the left mouse button and drag the mouse in any direction across  the 

text to be selected. 
The selected text will be highlighted. 
 
Cut 
1. Select the Text to be cut. 
2. Select the Cut option from the Edit menu, or click on the Cut button of the 

standard toolbar. 
Alternatively, select the text and press Ctrl+X. 
 
Copy 
1. Select the Text to be cut. 
2. Select the Copy option from the Edit menu, or click on the Copy button of the 

standard toolbar. 
Alternatively, select the text and press Ctrl+C. 
 
Paste 
1.   Position the insertion point at the location where the text should appear.  
2.   Select the Paste option from the Edit menu, or click on the Paste button of the 

standard toolbar. 
Alternatively, Position the insertion point and press Ctrl+V. 

 
 Font and size selection, bold, italic and underline 

 
Formatting a document includes assigning fonts and font sizes, aligning text, dividing 
text into columns, adjusting the line and paragraph spacing, and setting margins. In 
the following section, you will learn how to format text. 
 
Changing Fonts and Style 
Font refers to the manner or style in which text is displayed in the document. 
Different fonts contain different collection of characters and symbols. Word offers 
many ways to change fonts and font styles. The text to be formatted needs to be 
selected first. 
 
The steps to change font styles are: 
1.  Select the text whose font has to be changed. 
2.  Click on the down-arrow to the right of the Font list box in the Formatting 

toolbar. 
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A list of available fonts is displayed as shown in the following figure. 
 

 
 
 

 3.  Select a font from the list. 
 4.  Use one or more options explained in Table 1.3. 
 

Button Name Sample Output 
Bold Changing font style.
Italic Changing font style. 
Underline Changing font style. 

  
 Changing Font SIZE 

 
Font’s size is measured in points. Points and picas are used for measuring spacing, 
line thickness, and so on. There are 12 points to a pica and six picas to an inch; 
therefore, there are 72 points to an inch. Normal template document is 10 points 
Times New Roman, by default. Word offers many ways to choose font sizes. 
 
The steps to change the font size are: 
1.   Select the text whose font size has to be changed. 
2.   Click on the down-arrow to the right of the Font Size list box in the  
 
A list of available font’s sizes is displayed. 
 

 
 
   Select a font size from the list 
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Alignment of Text: Center, Left, Right and Justify 
 
Alignment's a way of organizing the text. It refers to the position of the text relative to 
the margins. Word enables the user to left-align, right-align, center-align and justify 
the text in the document in order to enhance it. This can be  done by using the four 
formatting toolbar buttons: 

 
 

 
By default, Word uses left alignment. It is a good policy not to use spaces to center 
your text. Type the text at left margin and press the Center button to center your text. 
 
Right-aligned Text 
 
Text is said to be right-aligned if it is aligned with the right margin of the page. To 
right-align a paragraph, position the cursor on any line within the paragraph and click 
on the Align Right button on the Formatting toolbar. 
 
Left-aligned Text 
 
Text is said to be left-aligned if it is aligned with the left margin of the page. This is 
the default mode of alignment. To left-align a paragraph, position the cursor on any 
line within the paragraph, and click on the Align Left button on the Formatting 
toolbar. 
 
Centered Text 
 
The center option is normally used to center the heading and text. To center a line of 
text, position the cursor on the line and click on the Center button on the Formatting 
toolbar. 
 
Justified Text 
 
This feature aligns a paragraph with both the left and the right margins. Inter-word 
spacing is adjusted such that each line of text begins at the left margin and ends at the 
right margin. To justify a line of text, position the cursor on that line and click on the 
Justify button on the formatting toolbar. 

 
Formatting the Text: Changing the Font, Size and Color 

 
 Using the Font Dialog Box 
 Font dialog box contains most comprehensive collection of formatting options. 
 
 The steps to open the Font dialog box are: 
 1.    Select the Font option from the Format menu, 
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The Font dialog box is displayed as shown in the following Figure. 
 

 
 
 

2.    Make the appropriate selections for the Fonts, Style, size and color from 
 the dialog box. 
 
Using the Format Painter 
 
The Format Painter is used to format an entire document quickly and easily. The 
Format Painter copies formats from the selected text to the text you want to 
format. Suppose, you have formatted a line as Times New Roman, bold, italic, 
underline and left-aligned. Rather than formatting each paragraph of the 
document separately, the Format Painter can be used to format the entire 
document. 

 
The steps to copy character formatting are: 
1.   Select the text whose format is to be copied. 
2.   Click on the Format Painter button in the standard toolbar. 
 The mouse pointer changes to a paintbrush with an I-beam. 
3.   Select the text to be formatted. 
 The text automatically changes to the copied format. 
4.   Press the Esc key when formatting is over or click on the Format Painter   

Button again. 
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  Paragraph Indenting, Bullets and Numbering 
 
Indenting Text 
Indenting is making your text look more eye-catching. Indents are added to margins, 
thereby increasing the white space and decreasing the text area for specific 
paragraphs. 
 

You can indent your text by using the: 
• Ruler 
• Paragraph dialog box 
 

Using the Ruler 
The steps to set the left and right indents with the ruler bar are: 
 
1.   Select the paragraph(s) for which you want to set tabs. 
2.   Point to and then drag the appropriate triangular indent markers to the desired 
locations. 
 

 
 

 When you release the mouse button, the text will be indented according to the  
 specification.  
 

Using the Paragraph Dialog Box 
  
Using the Paragraph dialog box, you can specify the left, right, first line and hanging 
indents. 
The steps to set indents for text by using the paragraph dialog box are: 
1.   Select paragraph(s) to be indented. 
2. Select the Paragraph option of the Format menu. 
 
The Paragraph dialog box is displayed. 
3. Enter the specifications in the Left or Right Indentation spin box. 
You can also select First Line or Hanging indent from the Special drop-down list box. 
4. Select a value in the by spin box. 
5. Click on the OK button. 
 
Creating Bulleted and Numbered Lists 
You can use bullets and numbers to make the lists in your document attractive and 
easy to read. You can bullet or number your lists by using Bullets and Numbering 
dialog box. 
 
The steps to add bullets or numbers are: 
1. Select an existing list or type in a new list. 
2. Select the Bullets and Numbering option from the Format menu. 
The Bullets and Numbering dialog box is displayed as shown in the following Figure. 

 



37 

 
 

3. Select a bullet style of your choice. 
4. Click on the OK button. 

 
 Cut, Copy and Paste across the documents 

 
If a text is required to cut or copy into another document, following steps are taken: 
1. Leave the current document open. 
2. Open another document from the File menu OR open new document. 
3. Select the text, paragraph to be copied into another document 
4. Select Cut or Copy option from the Edit menu 
5. Click on Window from the standard toolbar. 

 6.  A list of opened word documents will be displayed Select another  
 Document from that list. 
7. Put the cursor in the document where the text is to be copied. Select  

Paste  option from the Edit menu. 
The Selected text / paragraphs will be copied on that location. 

 
 Use of Tab and Tab Setting, Changing case 

 
Use of Tab 
Tabs are used for creating quick, relatively simple lists. Working with tabs is a two-part 
process. The first step is to set the tab stops. Word offers five types of tab stops—Left, 
Center, Right, Decimal and Bar tabs. The default tab stop is left. The second step in using 
tabs is to press the Tab key as the document is typed, to move the insertion point forward 
to the next tab stop. The default tab-stop position is 0.5 inch. 
 
Changing Case 
The steps to convert the case of text are : 
1. Select the text to be changed. 
2.    Select the Change Case option from the Format menu.  
 A Change Case dialog box is displayed as in the following figure: 
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3. Select the desired option. 
4. Click on the OK button. 
 
Following Table lists the various options of the Change Case dialog box along with 
their function. 

 
Option Function 

Sentence case Capitalizes only the first letter in the selected sentences. 
lowercase Converts all selected text to lowercase letters. 
UPPER CAS E Converts all selected text to uppercase letters. 
Title Case Capitalizes the first letter of each word of the selected text. 
tOGGLE cASE Changes uppercase to lowercase and lowercase to 

uppercase in all selected text. 

 
 
  Spelling and Grammar Check 
 

Some of the content in this topic may not be applicable to some languages. By 
default, Microsoft Word checks spelling and grammar automatically as you type, 
using wavy red underlines to indicate possible spelling problems and wavy green 
underlines to indicate possible grammatical problems. 
 
• You can also check spelling and grammar all at once. 
 
• Check spelling and grammar automatically as you type 
 
To make automatic spelling and grammar checking are turned on: 
 
1. On the Tools menu, click Options, and then click the Spelling & Grammar tab.  
2.  Select the Check spelling as you type and Check grammar as you type check 
 boxes.  
3. Type in the document.  
4. Right-click a word with a wavy red or green underline, and then select the 
 command or the spelling alternative you want.  
Check spelling and grammar all at once 
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This method is useful if you want to postpone proofing a document until after you 
finish editing it. You can check for possible spelling and grammatical problems, and 
then confirm each correction. 
 
If you want to check spelling only,  
1.  Click Options on the Tools menu,  
 
2. Click the Spelling & Grammar tab, clear the Check grammar with spelling check 

box and then click OK.  

3. On the Standard toolbar, click Spelling and Grammar .  
 
A Spelling and Grammar Dialog box will appear as in the following figure: 

 

 
 

You can correct spelling and grammar directly in the document while the Spelling 
and Grammar dialog box is open.  
 
Type your correction in the document, and then click Resume in the Spelling and 
Grammar dialog box.  
 
For a detailed explanation of a grammar flag, click Explain in the Spelling and 
Grammar dialog box.   
 
If you mistype a word but the result is not a misspelling (for example, "from" instead 
of "form" or "there" instead of "their"), the spelling checker will not flag the word. 
 

  Use of Drawing Tools 
 

You can add a variety of diagrams using the diagramming tools on the Drawing 
toolbar. Diagram types include Cycle, Target, Radial, Venn, and Pyramid. Use the 
diagrams to illustrate various conceptual materials and to enliven documents 
(diagrams are not numerically based). 
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To see a drawing toolbar, Right click on any toolbar, a list of toolbar will be 
displayed. 
 
Tick on Drawing Toolbar, A drawing toolbar will be displayed at the bottom of the 
word work area as in the following figure. 
 

 

 
 
 

Draw a curve 
 
1. On the Drawing toolbar, click AutoShapes, point to Lines, and then click 
 Curve.  
2. Click where you want the curve to start, and then continue to move the mouse 
 and click wherever you want to add a curve.  
3. To end the curve, double-click at any time.  

 
Flowcharts 
 
Flowcharts (or flow diagrams) can be created using a combination of AutoShapes on 
the Drawing toolbar, including flowchart shapes and connectors. 

 

 
 
 Tables 
 
 Concept of Tables: Rows, Columns and Cells 

Horizontal elements are called Rows, Vertical lines are called Column and cress 
section of row and a column is called Cell. 
 
Draw Table 
To insert a table, following steps are taken: 
1. Click on Table from Standard menu bar 
2. Select Insert from Table and then select Table. 
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An Insert Table dialog box will appear as in the following figure 
 

 
 

3. Insert no of Rows and Column into the proper box  in dialog box 
4. Click Ok 
 
Changing cell width and Height 
Following steps are taken to change the cell Width and Height: 
1. Select the cell for which the width and height is to be changed 
2. Click on Table and Select Table Properties 
3.  A Table Properties dialog box will appear 
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4. Click on Row Tab. 
5.  Select the row height from the drop down list box. 
6.  Click on Column Tab. 
7. Select the proper width from the preferred width box. 
 
Alignment of Text in cell 
 
1. Put a cursor in a cell. 
2. Click on Left, Center, and Right button on the Formatting Toolbar. 
Copying of Cell 
 
1. Select a Cell which is to be copied. 
2. Press Ctrl+C OR Select Copy from Edit Menu OR Select Cell from  
 Table->Select. 
3. Put a cursor into cell where the text is to be copied. 
4. Press Ctrl+V  OR Select Paste from Edit . 

 



43 

Advanced Features 
 

Mail Merge 
You can use the Mail Merge to create form letters, mailing labels, envelopes, or 
catalogs.  
 
This option now is widely used because 

• It allows to you to use word for more than just word processing. 
• It saves time. 
• It also allows you to import date stored in an Excel or an Access database into  

Word document, or even to import the entire database into Word. 
 
 Step 1: Creating or specifying the main document 

Click New Blank Document on the Standard toolbar. On the Tools menu, click 
Mail Merge. 

 

 
Under Main document, click Create, and then click Form Letters… 
 

.  
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 Step 2: Open or create the data source 

Create a new data source: If you haven't already stored names, addresses, and other 
data in a data source, and you want to store the data in a Microsoft Word table then 
Use this method.  

 
 

 Step 3: Create a new Word data source 
 

 
 
1. In the Field names in header row box, specify the data fields that you want to 

include in the data source. 
2. To delete a data field, click the field name in the Field names in header row 

box, and then click Remove Field Name. 
3. To add a data field, type a new field name in the Field name box, and then 

click Add Field Name. 
4. To change the order of the data fields, click a field name in the Field names in 

header row box, and then click one of the arrow buttons.  
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• When you finish specifying the data fields, click OK. 
• Locate the folder that you want to save the data source in, type a file name, 

and then click Save. 
 

 
 
• Click Edit Data Source. 

 

In the Data Form dialog box, fill in the information for each data record. 
o To fill in a record, type information for a data field, and then press 

ENTER to move to the next field. If you don't want to include information 
for a particular field, press ENTER to skip the field. Don't type spaces in 
the box. 

o To start a new data record, click Add New.  
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When you finish entering data records, save the data source by clicking View Source, 

and then clicking Save on the Standard toolbar. 

To return to the main document, click Mail Merge Main Document on the 
Database toolbar. 

Opening an Existing Data Source 
If you have already data source, there is no need to re-create that data in Word. 
Follow these steps to open an existing data source. 

 
Click on Get Data then select Open Data Source option. 

 

 
 
Locate the data source in open Data Source dialog box. Specify the table, query, or 
worksheet that contains the data in the dialog box that appears. Click OK. 
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 Step 4:  Adding Merge Fields to a Main Document 

1.  Open the main document, and then type any regular text in the document. For 
example, type the date, salutation, body, and closing of a form letter. To attach a 
data source to the main document, refer to step:3. 

 
2. Place the insertion point where you want to enter the first merge field, click the 

Insert Merge Field button on the Mail Merge toolbar, and select the merge field to 
insert. 

 

 
 
3. Repeat above step for each merge field you want to include in the main document. 
 

 
 

 Step 5: Previewing the merged Document 
 

When the main document and data source are merged, Word will generate a separate 
document or listing for each record in the data source, based on the layout of the 
document. Before you perform the merge, it is a good idea to see a sample of how the 
merged document will appear. 
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    See-Mail Merge effect on Screen 
 

 
 

Create mailing labels by merging an address list 
 

 Step 1: Create the main document 
 

1. Click New Blank Document on the Standard toolbar. 
2. On the Tools menu, click Mail Merge. 
3. Under Main document, click Create, and then click Mailing Labels. 
4. Click Active Window. The active document becomes the main document.  

 
Step 2: Open or create the data source 
In the Mail Merge Helper dialog box, do one of the following:  

• Create a new data source. Use this method if you haven't already stored 
names, addresses, and other data in a data source, and you want to store the 
data in a Microsoft Word table. 

• Use data in an existing data source. Under Data source, click Get Data, and 
then click Open Data Source. Select a Word document, or a worksheet, 
database, or other list, and then click Open. Click Set Up Main Document. 

• Use addresses from an electronic address book. Under Data source, click Get 
Data, and then click Use Address Book. Select an address book, and then click 
OK. Click Set Up Main Document.  

 
 



49 

 
 
 

 Step 3: Select the label type and insert merge fields 
 

1. If you don't see the Label Options dialog box, click anywhere in the main 
document, and then click Mail Merge on the Tools menu. Under Main document, 
click Setup. 

2. Select the type of printer and labels you want to use, and then click OK.  
If the type of labels that you want to use is not listed in the Product number box, 
you might be able to use one of the listed labels, or you can create your own 
custom labels.  

3. In the Create Labels dialog box, insert merge fields where you want to merge 
addresses from the data source. To insert a merge field, click Insert Merge Field, 
and then click the field name you want.  
See tips on inserting merge fields.  

4. If you want to include POSTNET bar codes on mailing labels, click Insert Postal 
Bar Code. Specify the merge fields that contain the ZIP Code and street address, 
and then click OK.  
Learn about POSTNET bar codes.  

5. Click OK.  
 

 Step 4: Merge the data into the main document 
 

1. If you want to specify the order in which data is merged, or merge only part of the 
data, you can sort and select data records to merge. 

2. If you want to see how the merged data will appear, you can preview the merged 
documents. 

3. In the Mail Merge Helper dialog box, click Merge under Merge the data with the 
document. 

4. If you want to check the data source for errors before you merge, click Check 
Errors. Choose an option, and then click OK 

. 
Do one of the following:  
o Send the merged labels directly to a printer. Click Printer in the Merge to box, and 

then click Merge. 
o Store the merged labels in a new document, so you can review, edit, and print 

them later.  
 

 Create mailing labels by merging an address list 
 

 Step 1: Create the main document 
 
1. Click New Blank Document on the Standard toolbar. 
2. On the Tools menu, click Mail Merge. 
3. Under Main document, click Create, and then click Mailing Labels. 
4. Click Active Window. The active document becomes the main document.  
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Step 2: Open or create the data source 
In the Mail Merge Helper dialog box, do one of the following:  

• Create a new data source. Use this method if you haven't already stored names, 
addresses, and other data in a data source, and you want to store the data in a 
Microsoft Word table. 

• Use data in an existing data source. Under Data source, click Get Data, and then 
click Open Data Source. Select a Word document, or a worksheet, database, or 
other list, and then click Open. Click Set Up Main Document. 

• Use addresses from an electronic address book. Under Data source, click Get 
Data, and then click Use Address Book. Select an address book, and then click 
OK. Click Set Up Main Document.  

 Step 3: Select the label type and insert merge fields 
 

• If you don't see the Label Options dialog box, click anywhere in the main 
document, and then click Mail Merge on the Tools menu. Under Main document, 
click Setup. 

• Select the type of printer and labels you want to use, and then click OK.  
• If the type of labels that you want to use is not listed in the Product  number 

box, you might be able to use one of the listed labels, or you  can  create your 
own custom labels.  

• In the Create Labels dialog box, insert merge fields where you want to merge 
addresses from the data source. To insert a merge field, click Insert Merge Field, 
and then click the field name you want.  

• See tips on inserting merge fields.  
• If you want to include POSTNET bar codes on mailing labels, click Insert Postal 

Bar Code. Specify the merge fields that contain the ZIP Code and street address, 
and then click OK.  

• Learn about POSTNET bar codes.  
• Click OK.  

 
 Step 4: Merge the data into the main document 
 

• If you want to specify the order in which data is merged, or merge only 
 part of the data, you can sort and select data records to merge. 

• If you want to see how the merged data will appear, you can preview the merged 
documents. 

• In the Mail Merge Helper dialog box, click Merge under Merge the data with the 
document. 

• If you want to check the data source for errors before you merge, click Check 
Errors. Choose an option, and then click OK 

• Do one of the following:  
o Send the merged labels directly to a printer. Click Printer in the Merge to 

box, and then click Merge. 
o Store the merged labels in a new document, so you can review, edit, and 

print them later.  
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1.5   MS Outlook 2003 

 Configuring and Managing Microsoft Outlook and Outlook Express 
Click on the Microsoft Outlook Express Icon on the Microsoft Office menu and you 
will get the following screen follow simple steps as shown below: Click on Next 
 

 
 
Click on the upgrade base if you want to upgrade otherwise click on don't upgrade if 
you don't want it. 
 

 
 

Give you Name by which you want to be known as: e-mail address 
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 Write the name here like "ITI-KUBERNAGAR" 
 

 
 
 Write the e-mail address you want to configure on the Microsoft Outlook  Express 
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Configure the POP3 by Incoming and Outgoing server configuration 
 

 
 
 Give the e-mail address or login ID and the password and click to remember your 
 password. 
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Give the type of connection you would be connecting to the Internet i.e. by dialup, 
direct cable connect or through LAN 

 

 
 
 Click on next or finish and the finally screen will come 
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The moment you will configure above Microsoft Outlook it will show the following 
screen 

 

 
 
 Mail check 
  
 To check the mail from MS-Outlook Express click on Inbox or it shows Inbox 
 mail details 
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 Sending and receiving mail 
  
 To Send and receive the mails click on the Send/Receive options as shown below 
 

 
 
 
 Concept of Calendar, Contacts, Task, Newsgroup 

 
To set the Appointment and Calendar please click on the Calendar option and you get 
the following screen with calendar. Click on the particular date and set the time of 
meeting 
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 Set the Subject, Location, Label, set the start and end time and reminder time 
 

 
 

 To Add the Contact for Address and find them click on Contact option 
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Click on the Task option to get the Task screen and set the Task with selective 
options 

 

 
 
 Click on the Newsgroup option and you will get the following option screen 
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1.6 Internet Familiarity, Usage and E-mail 
 

Preface 
 
The Internet is the world's largest network. It has revolutionized the way in which 
people communicate with each other. It is actually a network of networks. This 
module aims at familiarizing you with fundamentals of the Internet, how it functions. 
 
The session consists of the history of the Internet. It also contains various advantages 
of Internet with the definition of World Wide Web. It gives an introduction to various 
browsers available for Internet access. 
 
Introduction to Internet 
 
Define the communication protocol of the Internet 
 
Understand the addressing system in the Internet Learn how to access the Internet 
Understand the World Wide Web {www) Understand the various services of the 
Web: 
Search Engines 
Universities on the Web 
•     Chat Rooms 
•     Electronic Commerce Understand the various Web browsers Understand the     
      Internet Explorer 
 
What is the Internet? 
 
Internet is an inter-connection between several computers of different types belonging 
to various networks all over the globe. It is a network of networks.      
 
The kind of colossal powers that the Internet gives your machine is mind-boggling. 
To send or receive data within a matter of seconds to someone placed beyond the 
Pacific was unthinkable before the advent of the Internet. The Internet represents the 
transformation and evolution of the entire information age. It is due to these factors 
that people all over the globe have recognized the Internet as their latest 
developmental tool. The Internet unleashes the power to communicate unlike any 
other novelties. The Internet is making a major impact on the information technology 
industry. Major companies like Microsoft, AT&T, Intel and IBM have reworked their 
business strategies vis-a vis the Internet. 
 
The Internet being a packet switching network, data is transmitted by converting it 
into small packets. The software that is responsible for making the Internet function 
efficiently is TCP/IP, which stands for Transmission Control Protocol /Internet 
Protocol. 
 
Accessing Internet 
 
Proper access to the Internet depends on two things, namely, the user's interface 
connection and the installed browser. Different networks provide different kinds of 
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services and connections. The type of connection chosen by the user will depend on 
the purpose for which the user intends to use the Internet. 
 
Advantages of the Internet 
 
The Internet is an ocean of information accessible to people across the world, but the 
way it can be put to use on various platforms is different. The Internet is 
simultaneously as a Medium. 

 
The Internet serves as a communication channel for anybody dealing with product 
marketing to corporate communications as a Market 
The Internet is a vast virtual market place where you can advertise and even order 
products from the market. 

 
 Medium for Internet Access  
 
Sr. 
No. 

Medium of Net Speed Instrument used Examples 

1 Telephone Line - 
Dialup Connection 

56.6 Kbps Modem - 
Modulator De-
modulator 

Internet Service 
Provider (ISP) Icenet, 
Satyam, BSNL etc. 

2 Telephone Line - 
ADSL Broadband 

256 Kbps or 
higher 

Router-USB, 
Ethernet 
Router-Ethernet, 
Wi-Fi and LAN 
card. 

BSNL in existing 
landline without 
disturbing the voice 
line 

3 Broadband 64 Kbps or 
higher 

Router + LAN card Through cable net 
Icenet, Aquara, 
Dishnet etc 

4 Leased Line 64 Kbps or 
higher 

Router BSNL, TATA etc 

5 Mobile phones and 
Fixed Wireless Loop 
(FWL) 

64 Kbps or 
higher 

Mobile (Latest 
mobile are with 
modem) 

Reliance, TATA, 
Hutch etc. 
Wi-Fi 

6 Satellite connections 64 Kbps or 
higher 

Satellite phone 
with modem 

BSNL, Reliance and 
more to come 

7 Cable network  64 Kbps or 
higher 

Router + LAN card SITI Cable network 

 
Notes 
 Speed of Internet connectivity depends upon the Medium used and the 

configuration of the Computer system being used. 
 The minimum connectivity in India goes from 28.8 Kbps in any of the dial-up 

land line connection to maximum of 512 Kbps or more in Broadband 
 Place operation and subjective traffic load on the main Server of the unit supplier 

of Internet also affects the Internet speed 
 Speed is measured in Kilo Bits per Second (KBPS) normally known as the baud 

rate of the instrument being used 
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WWW- World Wide Web and Web Browsers 
 

The Internet application that is currently drawing the most attention is the World 
Wide Web (WWW). WWW is a series of servers that are interconnected through 
hypertext. Hypertext is a method of presenting information in which certain text is 
highlighted that, when selected, displays more information on the particular topic. 
These highlighted items are called hyperlinks and allow the users to navigate from 
one document to another that" may be located on different servers. The user can use 
the browser software like Internet Explorer, Mosaic or Netscape Navigator to 
navigate the Web. A browser is a software that helps the user to navigate the WWW. 
The Web is a graphic medium with most Web pages having some amount of images. 
The term home page commonly refers to the index page of any organization or 
information source. The home page can have links that take the user to further levels 
of information within the same topic, or there can be links to other home pages. 
 
Common Terminologies Some of the most commonly-used terminologies related to 
www are: 
 Browser— is client software that allows the user to display and interact with a 

hypertext document. 
 Web server—is a place where pages reside. It is a program that responds to 

requests from Web browsers to retrieve resources. It is also used to refer to the 
computer that runs the server programs. Some popular Web servers available are 
Internet Information Server (IIS) from Microsoft, Fast Track from Netscape and 
Intra Netware from Novell. 

 Home page—is the first hypertext document displayed when the user follows a 
link to the Web server. 

 Hypertext Markup Language (HTML)—is the encoding scheme used to create 
a Web document. 

 Hypertext Transfer Protocol (HTTP)—is a protocol used on the Web to 
transfer hypertext documents. A protocol is a set of rules that the computers use to 
communicate logically. 

 Uniform Resource Locator (URL)—is a Web addressing scheme that spells out 
the exact location of an Internet resource. When the user clicks on a link, the 
browser reads the link to the document. The information about the link is 
provided to the browser by the URL. Any link from one document to another is 
always implemented by using a URL. A URL contains information about the 
location of the document. A URL may point to another HTML document or an 
image. Certain conventions have to be followed while writing a URL. A typical 
URL would be as follows: 

 
 
The Web is a world of information available at the click of a mouse. To use it, you 
need a computer, a connection to the Internet, and a browser. 
 
When you run your browser, it finds and displays pages of information. The function 
of a Web Browser is to interpret the programming language of the web pages 
(HTML,) and transform it into the words and graphics that you see on your screen. If 
you need more information, all you have to do is click on a hyperlink. On each page, 
certain words, phrases, or even images are highlighted, and clicking on them causes 
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the browser to go off and find another page, which probably contains more 
highlighted items, and so on. 
 
All Web documents are stored on so-called server computers, represented in the 
image by a factory. Users can inspect these documents by requesting them from their 
local (personal) computers, represented by the house, and called a client. 
All computers involved in the Web are connected by the Internet, represented by the 
roads.  

 
 
When you click on a hyperlink, your computer asks a server computer to return to 
you a document.  
 
Web Browsers 

 
 The browser is the program which is necessary for surfing the internet. 

Following are some examples of web browsers. Internet Explorer 6 is the dominating 
browser, XP is the most popular operating system, and most users are using a display 
with 800x600 pixels or more, with a color depth of at least 65K colors. 
 

 

Internet Explorer 
Internet Explorer (IE) by Microsoft is the most popular Internet browser today. IE 
was introduced in 1995 and passed Netscape in popularity in 1998. 

 

 

Netscape 
Netscape was the first commercial Internet browser. It was introduced in 1994. 
Netscape has gradually lost its popularity to Internet Explorer.  

 

 

Mozilla 
The Mozilla Project has grown from the ashes of Netscape. Browsers based on 
Mozilla code is the second largest browser family on the Internet today, representing 
about 20% of the Internet community. 

 

http://www.w3schools.com/browsers/browsers_explorer.asp
http://www.w3schools.com/browsers/browsers_netscape.asp
http://www.w3schools.com/browsers/browsers_mozilla.asp


64 

 

Firefox 
Firefox is a new browser from Mozilla. The browser is very promising and expected 
to gain a high market share. 

 

 

Opera 
Opera is a Norwegian Internet browser. It is known to be fast and small, standards-
compliant, and available for many operating systems. Opera is the preferred browser 
for a number of small devices like mobile phones and hand-held computers.  

 
     Surfing the Internet 
 

Using the above net browser we can navigate to the proper website as per our needs 
moving on the net i.e. surfing to be precise to say any thing i.e. the work you do on 
net with the basic fundamentals of internet being used is termed as surfing Say for 
example you may search for a website or a topic in a search engine this is a termed 
example of doing some work on net is termed as “surfing”. 
 
Search (Search Engines – Google etc. ) 
 
Search engines work with a little less human intervention. They send out spiders that 
work their way through sites and catalogue the content. Each one works a little 
differently and some are more powerful than others. If you are interested in learning 
more about this subject, dig into the FAQ index at Bot Spot. The best way to get 
relevant results from a search engine is to take the time to read the help files.  
 
Search Engine Sampler 
Alta Vista Search Engine  
This engine boasts some powerful searching capabilities; you can search for web 
sites, newsgroups and even for people. 
  

http://www.w3schools.com/browsers/browsers_firefox.asp
http://www.w3schools.com/browsers/browsers_opera.asp
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Google 
Search the WWW, images, newsgroups, and news feeds.  
 

http://www.google.com/


66 

 
   
Moving Around in a website 

 
 Yes, after giving the website address probably a name the website name on the 

browser you would be using would display the website contents as above. Navigating 
on the website is a simple task with clicking the content highlighted subjective matter 
on the site respective to your requirement.  

 These linking / highlighted options lead to the respective informative page to be 
opened and would give the information or may even link to the respective site if the 
website or information is linked.  

• Click the Home button at the top of the page to return to the site home page at any 
time.  

• Click the Jump To dropdown box in the top left corner of the page to see a list of 
places you can go. As you move around, this list changes to show what is 
available from your current location. (Some sites use other names instead of Jump 
To for this dropdown box.)  

• Some pages have lists of links at their bottoms that you can use to move to related 
pages.  

From any page except the home page you can also  

• Click a link in the navigation bar on the left to display the content of that 
element.  

• Click a breadcrumbs link at the top of the page to move to higher-level pages.  

 Related Topics  

• Getting Help  
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 Tune your Browser 

 If any other browser problems or problems with content that requires a player or plug-
in, try to tune the Browser to check your current browser and plug-ins and, if 
necessary, download and install a new browser and/or plug-ins. 

 
Printing or saving portion of web pages 

 
Printing portion of web pages 

 Printing a portion web pages is easier; normally the website gives an option of 
printing and saving with a symbol placed on the website itself to print the content of 
the page or to save it. 

 
 Moreover you can select in File menu and use Print option for printing the web page 

contents. Moreover similar process can be used for saving the content page or the 
whole page itself here is the screen. 

 

 
 
 Following screen shows the option of printing and saving web page  
 

 

 



68 

 Print the following image as shown in the figure 
 

 
 
 Saving portion of web pages... 
 
 Go in File menu -> Save As 
 

 
  

Give the file name  
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 Give the Save as type 
 

 
 
 
 Give Encoding option selective from the base 
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Saving options given by the Webmaster i.e. from the Website itself 
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 Saves the image as shown in the Figure 
 

 
 

Downloading 
 

Downloading refers to the method by which you 
access digital information from a remote 
computer. As it turns out, almost everything you 
do on the Web is some form of downloading --
it's as simple as clicking your mouse. When you 
access a web page, for instance, you are actually 
downloading the document and all its associated 
graphics from a web server. Once the digital 
data arrives, your web browser looks at the file 
extension (the letters following the "."). If it 
recognizes the type of file, it will display it. If it 
doesn't recognize it, it will ask you if you want 
to configure a viewer (tell the browser which 
software program to use to view the file). You 
also have an option to save the file to your hard 
drive.  

 Another way to download files is to click 
on the link to the file with your right mouse button (or hold the mouse button down if 
you are using a Mac), and select Save to Disk from the pop-up menu. In some cases, 
you will be prompted to save the file somewhere on your hard drive, or the file may 
download automatically to your desktop, depending on how your browser is 
configured.  
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Saving an Image 

Once a graphic or photo is displayed on your monitor, you may want to save it for 
future reference. Here's how to do it:  

Place your cursor over the graphic.  

Windows users: Click your right mouse button. A pop-up box appears. 
Macintosh users: Click and hold the mouse button until the pop-up box appears.  

Save the image to your hard drive by selecting the Save option.  

You can accept the current file name or rename the file. (Graphic files are usually 
in .gif or .jpg format.)  

Compressed and Self-Extracting Files 

With software, more often than not, you will be downloading files that have been 
compressed. These may be individual files or groups of files that have been 
compressed into a single file. This is done to save downloading time and disk space. 
If the files have been compressed, you need a separate software utility to decompress 
them.  

 
Follow these steps for downloading applications, plug-ins, games or any other 
software from the Internet.  
 

 

If you don't already have one, 
create a Temporary Files 
folder by opening Windows 
Explorer, highlighting your 
hard drive (typically the c: 
drive), then selecting 
File/New/Folder.  

When the folder appears, 
name it Temporary Files. 

http://www.learnthenet.com/english/html/93down.htm##
http://www.learnthenet.com/english/html/93down.htm##
http://www.learnthenet.com/english/html/93down.htm##
http://www.learnthenet.com/english/html/93down.htm##
http://www.learnthenet.com/english/html/93down.htm##
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Once you locate the software you 
want to download, click on the 
link to begin the download 
process. 

 

You will be asked 
where to save the file. 
Locate the Temporary 
Files folder on your 
hard drive and double 
click on it to open it. 

Click 
SAVE 
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If you are really bored, 
you can watch the file as 
it downloads.  

After the download is 
finished, you have to install 
the software. Close all 
programs that are running, 
except Windows Explorer. 
Find the file you downloaded 
and double click on it. 

A series of 
installation 
screens 
direct you 
through the 
process.  

New 
application 
programs 
are usually 
installed in 
the 
Program 
files folder. 
Plug-ins are 
usually 
installed in 
the 
appropriate 
browser 
folder.  

http://www.learnthenet.com/english/html/93down.htm##
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After the software 
is installed you 
can delete the file 
in your 
Temporary Files 
folder to free up 
space on your 
hard drive 
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1.7 Understanding LAN, WAN and Wireless LAN 
 
Network: One or more than one computers when connected to each other and are 
exchanging data and information vice-versa, is known as network of computers. 
 
Topologies of Network: The way in which computers are connected to each other i.e. 
in a network is knows as Topologies of network. They are as follows: 
 

   
                 Bus Topology    Ring Topology 
 

             
                Star Topology    Mesh Topology 
 
Types of Network: There are three types of Networks they are  
LAN: Local Area Network 
MAN: Metropolitan Area Network 
WAN: Wide Area Network 

 
 Introduction to LAN  
 
 A LAN (Local Are Network) - the computers are on the same site and linked by 

cables. 
 A MAN (Metropolitan Area Network) – 

Metropolitan Area Networks or MANs are large computer networks usually spanning 
a campus or a city. They typically use wireless infrastructure or optical fiber 
connections to link their sites. 
 
A metropolitan area network (MAN) is a network that interconnects users with 
computer resources in a geographic area or region larger than that covered by even a 
large local area network (LAN) but smaller than the area covered by a wide area 
network (WAN). The term is applied to the interconnection of networks in a city into 
a single larger network (which may then also offer efficient connection to a wide area 
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network). It is also used to mean the interconnection of several local area networks by 
bridging them with backbone lines. The latter usage is also sometimes referred to as a 
campus network.  
 
Examples of metropolitan area networks of various sizes can be found in the 
metropolitan areas of London, England; Lodz, Poland; and Geneva, Switzerland. 
Large universities also sometimes use the term to describe their networks. A recent 
trend is the installation of wireless MANs.  
 
 

 A WAN (Wide Area Network) - the computers are on different sites and are linked 
by telephone links. A computer may need to use a modem to link to the telephone 
system. 
 
Wide Area Networks, or WANs are very large networks of computers. These 
networks span large geographical areas, generally covering a couple miles, sometimes 
connecting computers thousands of miles apart. A WAN can also be a collection of 
LANs, bringing together many smaller networks into one large network. A WAN can 
constitute a very large corporate or government network, spanning the country or 
even the world. In fact, the Internet is the largest and most common WAN in 
existence today. 
 
Network media is the actual path over which an electrical signal travels as it moves 
from one component to another. The common types of network media are  twisted-
pair cable, coaxial cable, fiber-optic cable, and wireless. 
 
Wireless Communication  
Wireless communication uses radio frequencies (RF) or infrared (IR) waves to 
transmit data between devices on a LAN. For wireless LANs, a key component is the 
wireless hub, or access point, used for signal distribution.  

Connecting a LAN: The Physical Connection 

Regardless of type, all LANs require special hardware. The usual parallel and serial 
ports that come with personal computers are not fast enough for most uses on a LAN. 
At UIC, and probably most universities, each desktop computer that will be 
networked on a LAN must have an Ethernet card, which gives the desktop computer a 
third, very fast, type of communications port.  

In addition to LANs based on Ethernet hardware, in which data is broken up into 
small "packets" for transmission, including Twisted Pair Ethernet, Fast Ethernet (100 
Mbps vs. only 10 Mbps for regular Ethernets), and Gigabit Ethernet, there are "token 
passing" networks such as Token Ring and FDDI (Fiber Distributed Data Interface), 
and "cell relay" networks such as ATM (Asynchronous Transfer Model). Ethernet, 
Token Ring, and FDDI are all "base band" networks -- the wires carry only one signal 
(aka channel) at a time. ATM, which is part of B-ISDN (Broadband Integrated 
Services Digital Network), on the other hand, is "broadband", in which a single wire 
can carry multiple channels simultaneously.  

http://webopedia.internet.com/TERM/t/token.html
http://webopedia.internet.com/TERM/t/token.html
http://webopedia.internet.com/TERM/t/token_ring_network.html
http://webopedia.internet.com/TERM/F/FDDI.html
http://webopedia.internet.com/TERM/c/cell_relay.html
http://webopedia.internet.com/TERM/A/ATM.html
http://webopedia.internet.com/Standards/Communications_Standards/ISDN/ISDN.html
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All types of networks differ, of course, in cost and speed, and in necessary software 
and hardware. And all of these types of network are, or have been, used at UIC. (For 
more information about ATM, see Building the Data Highway and the other articles 
in the November/December 1996 ADN Connection newsletter.)  

Once a desktop computer has an appropriate network card installed, it can be 
connected to other computers through cables, hubs, and routers, so that the 
information can flow from one to another as quickly as possible. This is precisely 
how computers at UIC are connected to the UIC campus network and ultimately to 
the Internet. Commonly, "LAN hardware" also includes dedicated machines like file 
or print servers, which provide LAN services to really make the network a LAN. 

Hubs, switches and bridges  

Let’s now look at the various components that are used in a LAN and in a WAN. 

Hubs  

In the old days the LAN comprised mostly of devices called hubs or a concentrator in 
other words.  

A hub or a concentrator was a way of concentrating network connections in a single 
point. We said that hub’s ran at 10Mbps and essentially if you put 10 machines into a 
wire that was running a 10Mbps you would see that every machine could probably 
only transmit at 1Mbps even if they were transmitting at their maximum.  

This statement is not strictly true of course, because Ethernet is CSMA/CD, so there 
would be a back-off process and two machines would communicate with one another, 
ultimately using up their 10Mbps standard.  

Hubs were shared, they were slow, they were not optimal, primarily because you had 
a certain number of devices that you plugged in and the performance of Ethernet 
would degrade to such an extent that it was preferable not to even work on the 
network. That was in the bad old days!  

 

Switches  

Hubs then gave way to switches, the difference between a hub and a switch is that it 
when workstations started communicating with one another, they would essentially 
form a direct connection and even though other devices were connected these two 
workstations would talk directly to one another.  

They would create a virtual connection between the two devices that were 
communicating with each other.  

Once the conversation was complete that connection would be broken and then if a 
machine wanted to talk with a different workstation it would again create a virtual 
connection.  

http://www.uic.edu/depts/accc/newsletter/adn14/datahigh.html
http://www.uic.edu/depts/accc/newsletter/adn14/
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So you can see that at different times, different workstations could communicate with 
one another without interfering with each other's traffic, because there’s a virtual 
connection being established.  

Wireless Network  
 

To receive the signals from the access point, a PC or laptop must install a wireless 
adapter card (wireless NIC). Wireless signals are electromagnetic waves that can 
travel through the vacuum of outer space and through a medium such as air. 
Therefore, no physical medium is necessary for wireless signals, making them a very 
versatile way to build a network. Wireless signals use portions of the RF spectrum to 
transmit voice, video, and data. Wireless frequencies range from 3 kilohertz (kHz) to 
300 gigahertz (GHz). The data-transmission rates range from 9 kilobits per second 
(kbps) to as high as 54 Mbps. 
 
The primary difference between electromagnetic waves is their frequency. Low-
frequency electromagnetic waves have a long wavelength (the distance from one peak 
to the next on the sine wave), while high-frequency electromagnetic waves have a 
short wavelength. 
 
Some common applications of wireless data communication include the following: 
Accessing the Internet using a cellular phone 
Establishing a home or business Internet connection over satellite 
Beaming data between two hand-held computing devices 
Using a wireless keyboard and mouse for the PC 
 
Another common application of wireless data communication is the wireless LAN 
(WLAN), which is built in accordance with Institute of Electrical and Electronics 
Engineers (IEEE) 802.11 standards. WLANs typically use radio waves (for example, 
902 megahertz [MHz]), microwaves (for example, 2.4 GHz), and IR waves (for 
example, 820 nanometers [nm]) for communication. Wireless technologies are a 
crucial part of the today's networking.  

Architecture of a Wireless LAN 
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Stations 

All components that can connect into a wireless medium in a network are referred to 
as stations. All stations are equipped with wireless network interface cards (WNICs). 
Stations fall into one of two categories: Wireless Clients and Access Points. 

Access Points (AP’s) 

Access Points are base stations for the wireless network. They transmit and receive 
radio frequencies for wireless enabled devices to communicate with. 

Wireless Clients 

Wireless clients can be mobile devices such as laptops, personal digital assistants 
(PDAs), IP phones or fixed devices such as desktops and workstations that are 
equipped with a wireless network interface card. 

Basic Service Set 

The Basic Service Set (BSS) is a set of all stations that can communicate with each 
other. There are two types of BSS: Independent BSS and Infrastructure BSS. Every 
BSS has an id called the BSSID; it is the MAC address of the access point servicing 
the BSS. 

Independent Basic Service Set 

Independent BSS are an ad-hoc network that contain no Access Points. Since they do 
not use Access Points they can not connect to any other basic service sets. 

Infrastructure Basic Service Set 

An Infrastructure BSS can communicate with other stations not in the same basic 
service set by communicating to each other through Access Points. 

Extended Service Set 

An Extended Service Set (ESS) is a set of connected BSS. Access Points in an 
extended service set are connected by a distribution system. Each ESS has an ID 
called the SSID which is a 32 byte (maximum) character string. Example: linksys (the 
default SSID for Linksys routers). 

Distribution System 

A distribution system connects Access Points in an extended service set. A 
distribution system is usually a wired LAN but can be a wireless LAN. 
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Types of Wireless Local Area Networks 

Peer-to-peer or ad-hoc 

 
 

Peer-to-Peer or ad-hoc Wireless LAN 

This type of network allows wireless devices to directly communicate with each 
other. Wireless devices within range of each other can discover and communicate 
directly without involving central access points. This method is typically used by two 
computers so that they can connect to each other to form a network. 

If you have a strength meter for the signal coming from all the other ad-hoc devices 
the meter will not read the strength accurately, and can be misleading, because it is 
registering the strength of the strongest signal, such as the closest computer. 

Access Point or Infrastructure Wireless LAN 

 
Infrastructure Wireless Local Area Network 

The most common type of wireless LAN when a wireless enabled client connects to 
an access point in order to connect to the network. 

An access point is often a hub or router that has an antenna built in to transmit and 
receive the radio frequency and bridges a wireless network to a wired Ethernet 
network. The network administer can configure the access point through a web 
interface or telnet. 

Home networks typically have one access point that is directly connected to the 
internet to provide the network with internet access. Larger networks often found who 
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provide wireless access to entire buildings usually have multiple access points placed 
at strategic locations. 

Method of Communication 

A Wireless LAN is a local area network that uses radio frequencies to communicate 
between wireless enabled devices. The transmission frequency of a Wireless LAN 
depends on the protocol being used and the channel. 

Protocols 

IEEE 802.11 (Wi-Fi) 

In 1990, the IEEE (Institute of Electrical and Electronic Engineers) formed a group to 
develop a standard for wireless equipment. On June 26, 1997, a standard was finally 
developed called 802.11 

IEEE 802.15 (Bluetooth) 

Bluetooth provides a way to exchange information between wireless devices such as 
personal digital assistants (PDAs), mobile phones, laptops, computers, printers and 
digital cameras via a secure, low-cost, globally available short-range radio frequency 
band.  
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1.8 Overview & Usage of PDF 

Portable Document Format (PDF) is an open standard file format, proprietary to 
Adobe Systems, for representing two dimensional documents in a device independent 
and resolution independent format. Each PDF file encapsulates a complete 
description of a 2D document (and, with the advent of Acrobat 3D, embedded 3D 
documents) that includes the text, fonts, images, and 2D vector graphics that compose 
the document. Importantly, PDF files do not encode information that is specific to the 
application software, hardware, or operating system used to create or view the 
document. This feature ensures that a valid PDF will render exactly the same 
regardless of its origin or destination.  
 
PDF files are most appropriately used to encode the exact look of a document in a 
device-independent way. While the PDF format can describe very simple one page 
documents, it may also be used for many pages, complex documents that use a variety 
of different fonts, graphics, colors, and images. 

PDF and accessibility 

Microsoft Word documents can be converted into accessible PDFs, but only if the 
Word document is written with accessibility in mind - for example, using styles, 
correct paragraph mark-up and "alt" (alternative) text for images, and so on. 

Multiplatform — Viewable and printable on any platform — Macintosh, 
Microsoft® Windows®, UNIX®, and many mobile platforms. 

Maintain information integrity — Adobe PDF files look exactly like original 
documents and preserve source file information — text, drawings, 3D, full-color 
graphics, photos, and even business logic — regardless of the application used to 
create them. 

Searchable — Leverage full-text search features to locate words, bookmarks, and 
data fields in documents. 

Accessible — Adobe PDF documents work with assistive technology to help make 
information accessible to people with disabilities. 
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Section – 2 
Microsoft Office Indic 2003 (Gujarati) 
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2.1 Introduction about MS Office 2003 Indic 

Microsoft introduced new MS OFFICE 2003 Indic suit, in which user can type in six 
Indian Languages like Hindi, Gujarati, Kannada, Malayalam, Tamil and Bengali. 
Gujarati Indic IME gives a very convenient way of entering text in Gujarati using the 
English QWERT keyboard in any Office XP application, WordPad and notepad on 
Windows XP platform. 

2.2 How to start Word? Method of Starting Word 2003 

Following steps are used to start Word 2003 

1. Click on Start  

 

2. Point to Programs -> Microsoft Office -> Microsoft Office Word 2003 

3. Click on Microsoft Office Word 2003 

2.3 How to Change Language English to Gujarati? 

Following Steps are taken to change language English to Gujarati. 

1. Hold down the Alt Key and Press the Shift Key to toggle language from  
English -> Gujarati -> English.   OR 
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1. Click on ‘EN’ from Task Bar. 
2. Click on ‘GU’ from pull up Bar. 

A Gujarati tool bar will be displayed as shown in the following figure 

 

2.4 Introduction about the Gujarati Keyboards 

Gujarati Indic IME provides support for five types of keyboard:  
 

• Gujarati Transliteration – Using phonetic typing, the user can type his message 

in Roman using the Standard English keyboard, which is transliterated on-the-fly 

to Gujarati. It works on the logic of phonetics and is most effective when you 

spell the word the way it is spoken. 

• Gujarati Typewriter- Another Gujarati keyboard used in typing. Typing can be 

done as per the key mapping of Gujarati typewriter keyboard. 

• Gujarati Inscript - Another Gujarati Keyboard where the user types the basic 

characters in sequence and an underlying logic determines that which of these 

characters have to be combined and substituted to form a glyph. 
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• Gujarati Remington Indica- Another Gujarati keyboard used in typing. Typing 

can be done as per the key mapping of Gujarati Remington Indica keyboard. 

• Gujarati Godrej Indica- Another Gujarati keyboard used in typing. Typing can 

be done as per the key mapping of Gujarati Godrej Indica keyboard. 

• Gujarati Special Character – Another keyboard contains all possible special 

characters in Gujarati. 

• Terafont keyboard – Another Gujarati keyboard used in typing. Typing can be 

done as per the key mapping of Terafont keyboard. 

2.5 Introduction about the Gujarati IME 

Input method Editor (IME) gives a very convenient way of entering text in Gujarati 
using the English QWERTY keyboard in any Office XP application, wordpad and 
notepad on Windows XP application, and have the text on the fly get converted to 
Gujarati. Indic IME has several features such as Auto Text, Customized word list, on-
the-fly Help, Different Keyboards Bilingual Composing of Text etc. which facilitate 
the user to compose in Gujarati conveniently.  

How to Use Gujarati Indic IME: 
1. After installing Gujarati Indic IME start any Office application, WordPad or 

Notepad.  
2. Click the Language Indicator located in the System Tray on the right side of the 

Windows taskbar, and click to select “Gujarati Indic IME 1” from the shortcut 
menu that appears.  

3. Start typing in Gujarati. 

 

  

Gujarati/Engl
ish

Keyboard Selection

AutoTextAutoTe

Customiz
ed 

On the fly Help 
On/Off 

On the fly
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2.6 How to operate the Keyboards 
 

Use the following different Keyboard Layouts for Gujarati Typing 
All the Keyboard layouts below shows all the Gujarati characters that are mapped to 
the Standard English keyboard of different keyboards : 

 
1. Gujarati Typewriter keyboard 

 
 

Use the following different characters  for Typewriter Keyboard 

Input Output 

ક્ષ્   +  aa matra      ક્ષ 
શ્   +  aa matra       શ 
દ   + aa matra ઘ 
પ્     +  aa matra  પ 
ભ્    +  aa matra ભ 
ચ્     +  aa matra ચ 
ત્    +  aa matra ત 
થ્  +  aa matra થ 
ઞ્    +  aa matra ગ 
બ્    +  aa matra બ 
મ્    +  aa matra મ 
ન્    +  aa matra ન 
વ્    +  aa matra વ 
સ્    +  aa matra સ 
ખ્    +  aa matra ખ 
 લ્   +  aa matra લ 

 
 
 

2. Gujarati Inscript Keyboard 
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3. Gujarati Ramington Indica Keyboard 
 

 
 
 
 

4. Gujarati Godrej Indica Keyboard 
 

 
 
 
 
 
 
 

5. Gujarati Special Character Keyboard 
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6. Gujarati Terafont keyboard 

 
 
 

 What is Transliteration K/B ? 

Transliteration is a Keyboard Layout in which the user can type the words in Roman 
English using the standard keyboard layout. The word is translated into Gujarati on 
the fly using phonetic logic. The word is translated in spell as it is spoken. 

2.7 How to type different Characters and Words from transliteration K/B? 

Followings are the list of character assigned to keys for Transliteration Keyboard. 

 

 

 

 

 

 

1. Vowels 
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Roman Gujarati 
a અ 
aa આ 
I ઇ 

ee ઈ 
u ઉ 
oo ઊ 
e એ 

ai / ei ઐ 
o ઓ 

au / ou ઔ 
a^ અં 
aH અઃ 
aM અઁ 
O ઑ 
A ઍ 

Ra / Ru / Ri ઋ 
OM ૐ 

2. Consonants 

Roman Gujarati 
ka ક 
kha ખ 
ga ગ 
gha ઘ 
Nga ઙ 
cha ચ 
chha છ 

ja જ 
jha ઝ 
Nja ઞ 
Ta ટ 
Tha ઠ 
Da ડ 
Dha ઢ 
Na ણ 
ta ત 
tha થ 
da દ 
dha ધ 
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na ન 
pa પ 
pha ફ 
ba બ 
bha ભ 
ma મ 
ya વ 
ra ર 
la લ 

va / wa વ 
sha શ 
Sha ષ 
sa સ 
ha હ 

kSha / xa ક્ષ 
tra ત્ર 

Gya / jNja જ્ઞ 
R ઋ 
La ળ 

3. Consonants with Matra 

Roman Gujarati 
ka ક 
kaa કા 
ki કિ 

kee કી 
ku કુ 
koo કૂ 
ke કે 

kai / kei કૈ 
ko કો 

kau / kou કૌ 
ka^ કં 
kaH કઃ 
kaM કઁ 
kO કૉ 
kA કૅ 

kRa / kRu / kRi કૃ 
kra ક્ર 
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2.8 How to use IME Help ? 

On-the-Fly Help 

Indic IME provides online help of the English character mapping along with Gujarati. 
As the user types, help for each character or matra is available on the screen, helping 
the user in typing. To turn on the On-the-Fly help, you have to click on the On-the-
Fly Help button shown in the bottom right corner of then Word Screen. 

Spelling Check in Gujarati 

Microsoft Word with Indic languages enabled checks the spelling of Indic language 
words and other words automatically as it encounters them. You do not need to 
perform a separate spelling check for each language. 

There are two ways to check spelling grammar in Gujarati.  

1. When the typing of word finishes, a red underline appears under the word which 
spelling is wrong. 

2. Right click on the word, a menu will appear which shows the correct word 

OR 
 
1. Select the word, Click on Tools -> Spelling and Grammar OR Press F7 key. 
2. It shows the dialog box with the suggested word. You can choose the correct 

word from the listed word. 
 
2.9 What is Smart Tag? 

You can save time by using smart tags (smart tags: Data recognized and labeled as a 
particular type. For example, a person's name or the name of a recent Microsoft 
Outlook e-mail message recipient is a type of data that can be recognized and labeled 
with a smart tag.) to perform actions (actions: Tasks that can be performed by using 
smart tags. For example, adding a name to a Microsoft Outlook Contacts folder is one 
action that might be taken with a person name smart tag.) in Microsoft Word that 
you'd normally open other programs to do. 

The purple dotted lines beneath text in your document indicate the smart tags. 

 
How to use smart tags 

When Word recognizes types of data, it marks the data with a smart tag indicator, a 
purple dotted underline. To find out what actions you can take with a smart tag, move 
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the insertion point over the underlined text until the Smart Tag Actions button 
appears. You can then click the button to see a list of actions you can take. 

 
Smart Tag Actions button 

Smart tag indicator 

When you save a document, the smart tags are embedded so that they are available to 
anyone who opens the document. You can, however, choose not to embed smart tags 
when you save a document. 

If you save as a Web page a Word document that contains smart tags, some tasks can 
be performed on the Web using Microsoft Internet Explorer 5 or later. You can also 
use smart tags in your Microsoft Outlook e-mail messages and in Microsoft Excel. 

How smart tags work 

You enable smart tags by selecting smart tag recognizers from a list (Tools menu, 
AutoCorrect Options command, Smart Tags tab). Each smart tag recognizer 
identifies a type of data, such as names, dates, or telephone numbers, and contains the 
logic needed to provide one or more actions for each data type. 

When you type text into a new document or open an existing document, the logic in 
the smart tag looks for words that match the data types in the list. When the smart tag 
finds a match, it places a smart tag indicator— a dotted purple line— under the term 
and enables the appropriate actions. 

The actions you can take depend on the type of data that Word recognizes and labels 
with a smart tag. 

For example, "Nate Sun" in the previous example is recognized as a "person name" 
smart tag with actions you can take, such as Open Contact, Schedule a Meeting, 
Add to Contacts, or Insert Address. 

If you select the Add to Contacts action, you can add the name and address to your 
Outlook contact folder without copying the information, opening Outlook, and then 
pasting the information into a contact card. 

What is a Thesaurus? 
 

Thesaurus is a dictionary of synonyms. Followings are the steps to use thesaurus. 
 

1. On the Tools menu, click Research.  
2. In the Search for list, select Thesaurus.  
3. Press ALT and click the word you want to look up.  
4. Results appear in the Research task pane. 
5. To use one of the words in the list of results or to search for more words, do one 

of the following:  
• To use one of the words, point to it, click the down arrow, and then click 

Insert or Copy.  
• To look up additional related words, click a word in the list of results. 
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You can also look up words in the thesaurus of another language. If, for example, 
your document is in French and you want synonyms, click Research options in the 
Research task pane, and then under Reference Books, select the thesaurus options 
you want.  
 
The thesaurus is installed by default. If, however, you receive no results from the 
thesaurus, you may need to reinstall it.  
 

In Microsoft Office Outlook 2003, the Research task pane is available only when you 
are reading or composing e-mail messages. 

 
2.10 How to change Menu from English to Gujarati 
 

Following are the steps to change the Menu from English to Gujarati. 
 
 
Step 1:  Before changing Menu, Close all the Microsoft Office Applications then  

 Click on the Start Button. 
 
Step 2:  Point to Programs -> Microsoft Office -> Microsoft Office Tools ->  

 Microsoft Office 2003 Language Settings. Click on it. (As shown in Fig.) 
 

 
 
Step 3:  Language Setting Dialog box will appear. Select ગુજરાતી from ‘Display  

 Office 2003 in’ drop down list box. 
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Step 4:  Select Help Language from ‘Display Help in’ drop down list box. Click Ok 
 

 
 
Now Start MS Word 2003. You can see the menu is changed from English to 
Gujarati. Every menu command is converted into related Gujarati Language. 
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2.11 Introduction about TBIL Converter 
 

TBIL Data Converter is a desktop application, which enables any user to transliterate 
data of MS Word Doc /Text /Access (MDB) /Excel (XLS) files in ASCII Font/ISCII 
/UTF/Roman format (supported by converter) to a Unicode document in 7 Indian 
languages supported by Microsoft and vice a versa.  
 
1. To convert the document from Roman to Unicode the source document must be in 

Times New Roman font. 
 
2. TBIL Data Converter can  convert text/doc file/access file from Unicode to Fonts 

but only for Gujarati and Hindi Language.  
 

3. TBIL Data Converter will be converting document only with the supported fonts.  
The supported languages for the converter are: 

 
a. Hindi, Tamil, Gujarati, Telugu, Kannada, Punjabi, Marathi 
b. The supported fonts for the TBIL Data Converter with respect to all 

languages are:  
 
How to use TBIL Data Converter? 
 
Before using TBIL Data Converter for conversion of Doc files, close all the other 
running word applications, especially the source file. 
 
Follow the steps given below for transliteration of the data in MS Word Doc/Text 
files/Access/Excel files from font/ASCII/Roman format to Unicode and vice versa. 
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Step 1:  
Open/Run the TBIL Data Converter application. Select the source file format for 
conversion. Click ‘GO’ button to continue 
 
 

 
 

Step 2:  
The next screen is “Source Font Selection” wizard.   
Specify the following Details: 
 
Case (A) 
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Source Language Select the language of Doc file/Text file from the 
options available in drop down.  Options are Hindi, 
Punjabi, Gujarati, Marathi, Tamil, Telugu, Kannada 
and None.  

Source Format If source language is selected None, Iscii, Phonetic and 
UTF Options are available. If source language is 
selected as any language, Ascii and Unicode options 
are available. 

Source Font This is the name of the font used in document. Select 
the font name available in the list, which is filtered on 
the basis of selected language. To convert the Roman 
documents select the Times New Roman here. 

Target Language The Target language is the language in which doc 
file/Text file will be converted.  

Target Format If target language is selected None, Iscii, Phonetic and 
UTF Options are available. If target language is 
selected as any language, Ascii and Unicode options 
are available. 

Target Font Select the Font in which the converted document will 
be available. 

 
After specifying above details click the ‘Next’ button. 
 
Step 3: 
Following screen will appear after step 2 
 
Case (A) 
 
If you select Doc/Txt file in the Splash Screen (Screen 1).You will see next screen 
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After specifying all the details, Press Next button. 
 
Step 4 
This Screen will appear which will show the details you selected and now you can 
press Convert Button to begin the conversion. 
 

 
 

Controls on this screen  
 

Button Description 
Convert  This Begins the conversion process. 
Back This will take you back to the previous Screen. 
Cancel You can close the application by clicking on this button 
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Step 5 
 
This Screen will appear. Which will show the completion of the conversion. 
Controls on this screen  
 
 

 
 

 
Button Description 

Next Table This will take you back to the screen where you can select another 
file for conversion. 

Exit You can close the application by clicking on this button 
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Section – 3 
Troubleshooting, Installation and Best Practices 
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3.1 Understanding Storage Devices 
 
 A device capable of storing data is called Storage Devices. The term usually refers to 

mass storage devices, such as disk and tape drives. Computer storage, computer 
memory, and often casually memory refer to computer components, devices and 
recording media that retain data for some interval of time. In contemporary usage, 
memory usually refers to a form of solid state storage known as random access 
memory (RAM) and sometimes other forms of fast but temporary storage. Similarly, 
storage more commonly refers to mass storage - optical discs, forms of magnetic 
storage like hard disks, and other types of storage which are slower than RAM, but of 
a more permanent nature. 

 
 Various forms of storage devices, divided according to their distance from the 
 central  processing unit. Therefore a computer system usually contains several 
 kinds of storage, each with an individual purpose, as shown in the diagram. 
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Primary storage: Primary storage is directly connected to the central  processing 
unit of the computer. It must be present for the CPU to function  correctly. 

 
 Secondary storage: Secondary storage is also known as "mass storage", as 
 shown in the diagram above. Secondary or mass storage is typically of much 
 greater capacity than primary storage (main memory), but it is also very much 
 slower. In modern computers, hard disks are usually used for mass  storage. 
 
 Tertiary storage: Tertiary storage is used in the realms of enterprise storage and 
 scientific computing on large computer systems and business computer networks. 

Off-line storage: Off-line storage is a system where the storage medium can be 
easily removed from the storage device. Off-line storage is used for data transfer  and 
archival purposes. In modern computers, floppy disks, optical discs and flash memory 
devices including "USB drives" are commonly used for off-line mass storage 
purposes. "Hot-pluggable" USB hard disks are also available. Off-line storage devices 
used in the past include magnetic tapes in many different sizes and formats, and 
removable Winchester disk drums. 

Let us understand some storage devices 
 
• Floppy Disk 

A floppy disk is a data storage device that is 
composed of a ring of thin, flexible (i.e. 
"floppy") magnetic storage medium encased in a 
square or rectangular plastic wallet. Floppy 
disks are read and written by a floppy disk 
drive or FDD, the latter initialism not to be 
confused with "fixed disk drive", which is an 
old IBM term for a hard disk drive. 

1. Write-protect tab  
2. Hub  
3. Shutter  
4. Plastic housing  
5. Paper ring  
6. Magnetic disk  
7. Disk sector  

 
 
 
 
 
 
 

 
 
 



108 

 
 
 

• Hard Disk 
 

A magnetic disk on which you 
can store computer data. The term 
hard is used to distinguish it from a 
soft, or floppy, disk. Hard disks 
hold more data and are faster than 
floppy disks. A hard disk, for 
example, can store anywhere from 
10 to more than 100 gigabytes, 
whereas most floppies have a 
maximum storage capacity of 1.4 
megabytes.  

A single hard disk usually consists of 
several platters. Each platter 
requires two read/write heads, one 
for each side. All the read/write 
heads are attached to a single 

access arm so that Hathey cannot move independently. Each platter has the same 
number of tracks, and a track location that cuts across all platters is called a cylinder. 
For example, a typical 84 megabyte hard disk for a PC might have two platters (four 
sides) and 1,053 cylinders.  

 
In general, hard disks are less portable than floppies, although it is possible to buy 
removable hard disks.  

 
Another media for external storage is the cartridge tape. It is particularly suitable for 
storage of large volumes of data. Now, CD- ROMs, DVDs and Magneto-Optical 
(MO) disks have also become an important media to store large volumes of data. 

 
• CD/DVD 

 
 

DVD (also known as "Digital Versatile Disc" or "Digital Video Disc") is an optical 
disc storage media format that can be used for data storage, including movies with 
high video and sound quality. DVDs resemble compact discs as their physical 
dimensions are the same (120 mm (4.72 inches) or occasionally 80 mm (3.15 inches) 
in diameter) but they are encoded in a different format and at a much higher density. 
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Short for digital versatile disc or digital video disc, a type of optical disk technology 
similar to the CD-ROM. A DVD holds a minimum of 4.7GB of data, enough for a 
full-length movie. DVDs are commonly used as a medium for digital representation 
of movies and other multimedia presentations that combine sound with graphics.  

The DVD specification supports disks with capacities of from 4.7GB to 17GB and 
access rates of 600KBps to 1.3 MBPS. One of the best features of DVD drives is that 
they are backward-compatible with CD-ROMs, meaning they can play old CD-
ROMs, CD-I disks, and video CDs, as well as new DVD-ROMs. Newer DVD players 
can also read CD-R disks.  

DVD uses MPEG-2 to compress video data.  

• Flash memory/Pen Drive 
 

 
 

A special type of EEPROM that can be erased and reprogrammed in blocks instead of 
one byte at a time. Many modern PCs have their BIOS stored on a flash memory chip 
so that it can easily be updated if necessary. Such a BIOS is sometimes called a flash 
BIOS. Flash memory is also popular in modems because it enables the modem 
manufacturer to support new protocols as they become standardized.  

   

Flash memory is a form of non-volatile memory that can be electrically erased and 
reprogrammed. Unlike EEPROM, it is erased and programmed in blocks consisting 
of multiple locations (in early flash the entire chip had to be erased at once). Flash 
memory costs far less than EEPROM and therefore has become the dominant 
technology wherever a significant amount of non-volatile, solid-state storage is 
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needed. Examples of applications include digital audio players, digital cameras and 
mobile phones. Flash memory is also used in USB flash drives, which are used for 
general storage and transfer of data between computers. It has also gained some 
popularity in the gaming market, where low-cost fast-loading memory in the order of 
a few hundred megabytes is required, such as in Nintendo DS cartridges. 

3.2 How to use a DVD/CD ROM and Floppy? 
 

Floppy disk and CD/DVD are read by there related driver device. Each driver 
device has allotted a letter to identify them. Letter ‘A’ and ‘B’ are allotted to 
floppy drive. C, D,... are allotted to the hard disk (and their partitions whatever 
it may be). Next letter after the  hard disk allotted is allotted to the CD/DVD 
drive. 
 

 Reading process of Floppy and CD/DVD is described below: 
 
 1. Insert the Floppy disk into Floppy disk drive. 
 
 2. Open My computer from Desktop. 
 

As shown in the following figure,  there are three drives, Hard (ACER (C:)) 
drive, Floppy (A:), drive and CD drive (D:).  
 
3. Insert the Floppy disk in drive A: or CD/DVD  in drive D: then double click  
    on it.  

 

 
  

The selected drive’s folder(s)/file(s) will be opened. Using explorer, we can 
manage the files and folders seen in the opened drive. 
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3.3 Burning CD/DVD 

In computing, optical disc authoring, including CD authoring and DVD authoring, 
known often as burning, is the process of recording source material—video, audio or 
other data—onto an optical disc (compact disc or DVD). 

Process 

Creating an optical disc usually involves first creating a disk image with a full file 
system designed for the optical disc, and then actually burning the image to the disc. 
Many programs create the disk image and burn in one bundled application, such that 
end-users do not even know the distinction. 

There are also packet-writing applications that do not require writing the entire disc at 
once, but allow writing parts at a time, allowing the disc to be used like a floppy. 

There exist many optical disc authoring technologies for optimizing the authoring 
process and preventing errors. Discs whose burn failed are colloquially termed 
coasters since that is all they are good for. 

Sessions 

Data on an optical disc is laid out in sessions. Each session consists of a lead-in, 
containing the session's Table of Contents, the program area in which the individual 
tracks are located, and the lead-out. 

The number of tracks is limited to 99 in a session. The specifications require at least 
one track in each session. The tracks are located in the program area of the session. 

In multisession discs, the lead-in areas contain addresses of the previous sessions. The 
TOC written in the lead-in of the latest session is used to access the tracks. 

TOC 

The Table of Contents (TOC) is the area where the layout of the tracks on the disc is 
described. It is located in the lead-in area of the disc session. The TOC on discs is in 
principle similar to partition table on hard drives. 

Nonstandard or corrupted TOC records are abused as a form of CD/DVD copy 
protection, in e.g. the key2audio scheme. 

Lead-In 

The lead-in area of a CD session is the starting part of the disc. It contains the TOC 
for the session, and the address of the next available free part of the disc available for 
the start of the next session, unless the disc is closed and therefore no more sessions 
can be added, or the disc is not multisession. 
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Lead-Out 

The lead-out area is the ending part of the CD session. When the session is closed, 
the lead-out area is written. 

The first lead-out is 6750 sectors (about 13 megabytes) long; each subsequent lead-
out is 2250 sectors (4 megabytes) long. 

Tracks 

A track is a consecutive set of sectors on the disc containing a block of data. One 
session may contain one or more tracks of the same or different types. There are 
several kinds of tracks: Audio tracks, Data tracks. 

Hardware 

Authoring is commonly done in software on computers with optical disc recorders. 
There are, however, stand-alone devices like personal video recorders which can also 
author and record discs. 

Software 

Use of optical disc recorders requires optical disc authoring software, (sometimes 
called "burning applications" or "burner applications"). Such software is usually sold 
with the recorder. 

File systems 

Optical disk file systems include ISO-9660 (often known simply as "ISO") and 
Universal Disk Format (UDF). ISO is most common for CDs and UDF is most 
common for DVDs. 

ISO 9660 

ISO 9660 is a format mainly used on CDs. The ISO 9660 can be extended with Joliet, 
Rock Ridge, El Torito, or the Apple ISO9660 Extensions. The Joliet file system was 
made by Microsoft. It makes it possible to have long file names, among other things. 
Rock Ridge is a system providing ownership, fewer restrictions on the file names, and 
more. El Torito makes it possible to boot from a CD. The Apple Extensions enables 
creator codes, file type, on so on. 

Universal Disk Format 

Universal Disk Format is a format. UDF can be extended with Mount Rainier which 
makes it possible to use the disc like a floppy. You can delete, create, modify files, 
without having to write the whole disc again. 
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3.4 Taking Data on and from a flash drive, pen drive 
 

Taking Data on and from a flash drive, pen drive 
 
What is Flash / Pen drive? 
 
Flash drive or pen drive is a fast access data storage device.It is connected to USB 
port of computer. USB means Universal Serial Bus. Communication with USB port is 
faster and easier. 

 
Data storage capacity of flash  / pen drive varies from 128 MB to upto 2 GB.It is easy 
to transport data through flash drive because it is a portable device and one can carry 
it in his/her pocket. It is very reliable compare to CD or Floppy. 
 
How to transfer data to and from flash/pen drive 
 
One has to just connect flash/pen drive to USB port of the computer. If operating 
system is Windows XP, then it will auto run flash drive. 

 
 

 
 

Select the option 'Open folder to view files' and press OK button 
 
You will find one additional drive in 'My Computer' named Removable disk. 
 
Now it will act as common hard disk drive means you can write data into and from it. 

 
Suppose you want to copy some files from your computer to pen drive then go to My 
Computer and copy files or folders you want to transfer and then click on removable 
disk in My Computer and paste the files or folders. 
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When you finished working with your pen drive do not directly pull out but follow 
procedure as shown below. 

 
Right click on USB recognition symbol on your taskbar and click on Safely Remove 
Hardware. 
 

 
 

Then you will get following screen  
 

 
 

Click on Jet flash and then click on OK button. So message will come  
 

 
 
Now you can pull out your flash/pen drive. 
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3.5 Using data and resources from a Local Area Network 

Most LANs connect workstations and personal computers. Each node (individual 
computer ) in a LAN has its own CPU with which it executes programs, but it also is 
able to access data and devices anywhere on the LAN. This means that many users 
can share expensive devices, such as laser printers, as well as data. Users can also use 
the LAN to communicate with each other, by sending e-mail or engaging in chat 
sessions.  

LANs are capable of transmitting data at very fast rates, much faster than data can be 
transmitted over a telephone line; but the distances are limited, and there is also a 
limit on the number of computers that can be attached to a single LAN. 

How many computers are connected in a network can be viewed through My 
Network Places. 
 
You will find My Network Places icon on your desktop. Click on it. 

 
Click on view workgroup computers. 

 

 
 

You will find computers connected in your network and which is switch on. 
 

Click on the computer with which you want to connect. 
 

You will find shared folders of that computer. 
 

Click on folder which you want to access and then copy files from it to your 
computer. 
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3.6 Using FTP to Upload/Downloading of Data from the Internet 

Because downloading files from the web is so easily done with a web browser such as 
Microsoft Internet Explorer or Netscape Navigator, it is reasonable to think uploading 
files would be just as easy. New web page authors quickly find, however, that 
uploading and managing web files can be tricky.  

Web hosting services often provide several ways to upload files to your web site. For 
example, many web hosting services support Microsoft FrontPage, a software 
program that enables you to create, manage, and publish (upload) your web site. 
Other web hosts offer their own file management systems. Virtually all web hosting 
services, however, support FTP (File Transfer Protocol) uploading.  

FTP is one of the earliest Internet applications and was designed for transferring files 
from one computer system to another computer system on the Internet. Using FTP to 
download files from another computer system to your computer system is very easy 
to do with your browser. Simply enter the URL address of the FTP server in your 
browser window. The browser then connects to the FTP server and you login. Many 
servers support "anonymous" FTP, that is, you do not have to have an account with 
the server to download files.  To log in as "anonymous," use "anonymous" as your ID 
and your e-mail address as your password. Once you are logged on, you will see the 
server's current directory and list of files. To download a file, you essentially just 
click on the file and save it to disk.  

Using FTP with your browser to upload files can be very complicated. A much better 
option for uploading files is to use one of the many available freeware and shareware 
FTP client programs available. Two of the most popular FTP client programs are 
WS_FTP for windows and Fetch for the Macintosh. You can use a web search engine 
to locate a source where you can download these programs.  

I chose WS_FTP because it is popular and because the reviews say it is easy to use. 
WS_FTP can be downloaded as a free version for home and educational use. For 
professional or corporate use.  

WS_FTP is simple and easy to install and use. After you connect to your ISP (Internet 
Service Provider), run the WS_FTP program by double-clicking on its icon. A dialog 
box will appear on your screen so that you can enter FTP server information. The 
program comes pre-configured to connect with over thirty servers, including AOL, 
Compaq, Microsoft, and the like. You can use the pre-configuration settings as a 
guide to configure a setting to connect to your web host server or to any other server.  

Once connected to the FTP server, the WS_FTP window will appear. Local system 
(your computer) information will appear on the left side of the window and remote 
system (the server) information will appear on the right side of the window. For each 
side, you can change directories, make directories, view files, and perform other 
functions. Uploading or downloading files is a breeze. To upload a file from your 
computer to the server, select a file from your computer and then click on the right 
arrow in the center of the window. To download a file from the server to your 
computer, select a file from the server window and then click on the left arrow.  
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3.7 Information on SCANNER and its usage 

A scanner is a device that analyzes a physical images such as a photograph, printed 
text, or handwriting or an object such as an ornament and converts it to a digital 
image. 

Various types of scanners are described below. 

Flatbed Scanner - The Flatbed scanner, as shown in the below illustration, is one of 
the most commonly used and most recommended scanners. 

 

 This scanner allows the user to place a full piece of paper, book, magazine, photo or 
any other object onto the bed of the scanner and have the capability to scan that 
object. 

Sheet feed - Another commonly used scanner which allows a user to scan pieces of 
paper into the computer. 

 

 

 

While the sheetfed is a less expensive solution when compared to the flatbed scanner, 
the sheetfed is limited to 400dpi and the available options which can be scanned. 
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Handheld - Today, not commonly used scanner option and can be difficult to find at 
stores. The handheld option allows the user to drag over select sections of pages, 
magazines, books and other objects scanning only sections. 

 

While a very inexpensive solution, it can be tedious to drag the handheld correctly. 
While scanning, it will be difficult to have a straight scan as well as if it is moved to 
slow / fast can cause distortion in the image being scanned. 

Cardscan - Excellent solution for anyone interested in scanning business cards for 
record purposes. 

 

While sometimes surprising, the cardscanners can sometimes be an expensive 
solution for only having the capability to scan business cards. 

Below is a brief overview explaining generally how a scanner gathers the information 
and sends it to your computer. 

Scanners  configuration 

Scanners in Control Panel enables you to install scanners, and other image-capturing 
devices.  

After a device is installed, you can use the Scanners and Cameras Wizard to 
download and save pictures on your computer in a folder you specify. You can also 
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view device properties, delete pictures from your camera, or print photos. You can 
even test your device to make sure everything is working properly. 

You can use Scanners and Cameras to link your device to a program on your 
computer. For example, you can set your computer to automatically open all of your 
scanned pictures in your program of choice.  

Windows automatically saves pictures to the My Pictures folder or to a subfolder 
you specify. If you save your files to any My Pictures subfolder or any folder 
customized as a pictures folder, Windows provides specialized tools and features you 
can use such as Windows Picture and Fax Viewer and the ability to view your 
pictures as a slideshow.  

Many cameras and scanners are Plug and Play. Windows detects Plug and Play 
devices after you plug them into your computer. Some devices automatically shut 
themselves off after a period of time. If your camera is connected to your computer, 
and it is not being detected, check to see that it is turned on.  
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INSTALLATIONS 
 
3.8 Installing basic softwares  

We will see the Installation procedure for Microsoft Office XP  Professional. 

Microsoft Office XP  Professional includes following Applications 

• Word  
• Excel  
• Access  
• PowerPoint  
• Outlook  

Minimum System Requirements for Microsoft Office XP Professional  

• Processor: 133 MHz or higher; Pentium III recommended.  
• Memory (RAM): Necessary RAM for the operating system plus an additional 8 

MB for each application running simultaneously.  

Hard drive space: 245 MB; an additional 115 MB is required on the hard disk where 
the operating system is installed.  

Procedure 

1. Insert Microsoft Office XP Professional CD into CD drive. 
2. Open CD’s folder in explorer. Click on Setup.exe 
3. In the Microsoft Office XP Professional  User information window, enter your 

User name, Initials, and Organization as you would like, and click Next. 
 

 
 

4. In the Microsoft Office XP Professional  Choose the type of installation you 
need  window, select Complete. 

 
NOTE: Selecting Complete will  install all applications and components in their 
entirety to your computer which is recommended for Microsoft Office and 
especially for computers that may not always be connected to the UW network. 
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The Custom option will allow you to install only  the specific  applications or 
components that you need. The Install Now option will install only the most 
common components for Microsoft Office XP Professional. If you select either 
Install Now or Custom, be aware that in the future, if you need to use a 
component you do not select, you must be connected to the UW network in order 
for the component to be installed.  

 
5.   In the Install to box, do not change the default location (unless you have reason 

to do so), and click Next. 
 

 
 

In the Microsoft Office XP Professional  Begin installation window, click Install 
to begin installation. 
   
6. In the Microsoft Office XP Professional window, click OK. You have 

completed the installation of Microsoft Office XP Professional. 
   

Opening a Microsoft Office Application  
• To open an Office application, click the Start menu button, point to Programs 

(or All Programs), and click whichever Office application you would like to 
open. 
   

• To create a shortcut on your Desktop for an application, click the Start menu 
button, point to Programs right-click and hold on the application you would like 
to create a shortcut for, drag it to the Desktop, then release the mouse. Click 
Create Shortcut(s) Here or Copy Here.  
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3.9 Installing CD Burning Software (Nero etc.) 
Step 1.  Insert CD into CD Drive which contains CD Burning Software. (e.g. Nero is 

used here).  Setup.exe will Run automatically. If not, Click on Setup.exe on 
CD drive. It will extracts the compressed files for intallation process. (see 
following figure) 

 

                   
 

Step 2.  After completing decompressing, Click on Next 
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Step 3. Click on ‘I accept the terms....’ . Click on Next. 

 
 

Step 4.  Enter User Name, Organization and  Serial No. of Software. Click on Next 
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Step 5. Select Typical or Custom setup type (recommanded Typical). Click on Next 

 
 

Step 6. Now installation process will continue. You can see the progress on screen. 
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Step 7.  As seen in the following fig., some default setting are required by the 
installer.  Click on Next 

 
 

Step 8.  After completing installation, Click on Finish. Now the CD Burning software 
is  ready to use. 
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3.10 Install a printer driver on a Windows 2000-based computer 
 
To install a printer driver locally on a Windows 2000 computer: 
 
Step 1. Click Start, point to Settings, and then click Printers. 
 
Step 2. Double-click Add Printer to start the Add Printer Wizard. 
 
Step 3. Click My Computer, and then click Next. 
 
Step 4. Click Add Port, click Local Port, and then click New Port. 
 
Step 5. In the Port Name box, type the path to the printer in the following format, 

where server is the name of the print server and printer is the name of the 
printer:  

 \\server\printer 
 
Step 6. Click OK, and then click Close. 
 
Install a printer driver on a Windows XP-based computer 
 
To install a printer driver locally on a Windows XP-based computer, follow these 
steps: 
 
Step 1. Click Start, click Control Panel, click Printers and Other Hardware, and 

then click Printers and Faxes. 
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Step 2.  Double-click Add Printer to start the Add Printer Wizard, and then click 
Next. 

 

 
 
Step 3. Click Local printer, clear the Automatically detect and install check box, 

and then click Next. 
 

 
 

Step 4. Click Create a new port, and then click Local Port in the Port type section. 
 
Step 5. In the Port Name box, type the path to the printer in the following format, 

where  server is the name of the print server and printer is the name of the 
printer: \\server\printer 
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Step 6.  Click Next, and then select a Windows 2000 or Windows XP driver for your 

printer. 
 
Step 7.  Click Next, and then follow the instructions to finish the wizard. 

 

How to install a local printer 

Step 1: In the Printers and Faxes folder, click Add Printer. Make certain that your 
printer is connected to your computer and is turned on. Click Next to launch 
the Add Printer Wizard. 

Step 2: Select Local printer. 

Step 3: Select the manufacturer and model of your printer. 

Step 4: Once you have located the printer you wish to install, click Next. 

Step 5: If you have a disk with the software for the printer, put it into your CD-ROM 
drive and then click the Have Disk button. Select the drive that contains this 
disk and then click OK. 

Step 6: Supply a name for the printer and determine whether you'd like this printer to 
serve as your default printer. It's always best to select the printer directly 
connected to your computer as your default printer. 

Step 7: Indicate whether you'd like this printer to be shared. This function is 
especially useful if your home is networked and the printer will be shared with 
other users. If so, click Share Name and assign a name to the printer that will 
be easily recognized by family members. 

Step 8: Click Yes to print a test page from your newly installed printer. 

Step 9: Click Next to review the settings for your new printer before completing the 
installation process. 

How to install a network printer 

Installing a network printer that's down the hall from your main home computer is 
just as easy. When the Add Printer Wizard asks you to select a printer, simply click 
Connect to This Printer. 

If you don't know the name of the network printer, you may select Browse for a 
Printer to search through a list of shared printers. Alternatively, if your network 
printer is on a network that uses an Internet address, click Connect to a Printer on 
the Internet and enter the address in the URL text box. The Add Printer Wizard can 
guide you through the installation process, but playing with preferences is up to you. 
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3.11 Installing/Adding  New Fonts  

To add a new font to your computer.... 

If you are using Microsoft Windows® XP 
 
Step 1. On the Start menu, click Control Panel.  
 
Step 2. In the Control Panel, double-click Fonts.  
 

 
 
Step 3. On the File menu, click Install New Font.  
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Step 4. Navigate to the location where you saved the downloaded or unzipped font, 
and, in the List of Fonts box, click the font you want to add  

 

 
 

Step 5. Click OK.  

If you are using Microsoft Windows 2000 

Step 1. On the Start menu, point to Settings, and then click Control Panel.  

Step 2. On the Control Panel, double-click Fonts.  

Step 3. On the File menu, click Install New Font.  

Step 4. Navigate to the location where you saved the downloaded or unzipped font, 
and in the List of Fonts box, click the font you want to add.  

Step 5. Click Ok.  

If you are using Microsoft Windows Millennium Edition 

Step 1. On the Start menu, point to Settings, and then click Control Panel.  

Step 2. On the Control Panel, double-click Fonts (if you don't see this option, click 
view  all Control Panel Options).  

Step 3. On the File menu, click Install New Font.  

Step 4. Click the drive and then click the folder that contains the font you want to add 
(if the menu doesn't automatically recognize the font name, you may need to 
unzip the font as described above).  
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Step 5. Click the font you want to add and click Ok.  

If you are using a different operating system, look up fonts in Help for your operating 
system. 

After you have followed these procedures, when you open a new Office document, 
you should see the new font listed in the Fonts menu.  

3.12 Installing any Drivers for new hardware (including sound driver) 

To install a device driver, 

• Connect the device to the appropriate port or slot on your computer, according to 
the device manufacturer's instructions. You may need to start or restart your 
computer.  

• If you need to start or restart your computer, Windows should detect the device 
and start the Found New Hardware wizard.  

• If you need to install a device, such as a sound card, into a slot inside your 
computer, shut down Windows and turn off the computer. Remove the computer 
cover and install the device in the appropriate slot. Replace the computer cover, 
and then turn on the computer.  

• If your device did not install properly, you may have an older, non-Plug and Play 
device. For more information about installing a non-Plug and Play device, see 
Related Topics.  

• If prompted, follow the instructions on the screen to choose a destination path to 
install drivers for the device.  

• If the device is a small computer system interface (SCSI) device, connect it to the 
SCSI port on your computer according to the device manufacturer's instructions. 
Restart or turn on your computer.  

• You need to be sure that the device number for the SCSI device is not used by 
another SCSI device. To change the device number, see the device manufacturer's 
instructions. 

• If the device is a universal serial bus (USB) or IEEE 1394 device, plug it into any 
USB or IEEE port on your computer. Follow the instructions that appear on your 
screen.  

• You do not need to shut down or turn off your computer when you install or plug 
in a USB or IEEE 1394 device. Although USB and IEEE 1394 are similar 
technologies, you cannot interchange USB connections with IEEE 1394 
connections. 
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 Following s the procedure to install any new hardware/device driver 

 Click on Start. Point to Setting. Click on Control Panel. 

 

 
 Click on Add Hardware from Control Panel 

The Add Hardware wizard will search for Added New   Hardware. Click on Next. 
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 The Wizard will search for new added hardware. 

 
 

If it doesn’t find any hardware, it will display following. 

 Click on ‘Yes,..’, then click on Next. 
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 As seen in the following figure,  Select ‘Have Disk...’ 

 

 Select a proper drive and folder where the driver files exist. 

 
Now the wizard  will install the selected device driver in the system, After completing 
the installation, the system need to restart. After restarting the system, the installed 
device will work. 
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3.13 Installing new Software and removing them using the Control Panel 
Installing the Software  

 
1. Start Windows® and place the New software CD in the CD-ROM drive, label 

side up. Close the CD-ROM tray and the software Installer will automatically 
launch. If the installation does not occur, double-click on the CD-ROM icon 
under My Computer and double-click on RunSetup.exe. Once the main window 
of the Installer appears, select the Install button to begin the installation process.  

 
2. To install the software you must agree to the Software License Agreement. Please 

read the Agreement before clicking on the Agree button, as you will be bound by 
the Agreement's terms.  

 
3. Choose the installation location and type. For most people the default installation 

location will be perfectly fine, but those with unusual system configurations may 
want to specify an alternate location. There are two installation types: each copies 
all the game files from the CD-ROM to your hard drive except the large voice-
over file, which is only copied if a "full" installation type is selected. We 
recommend the full installation if hard disk space allows; otherwise, the Inherit 
the Earth disc must be in the CD-ROM drive during play.  

 
4. Follow the prompts on the screen to complete the installation. You can read the 

on-disk Game Manual once the installation finishes.  
 

Uninstalling the Software  
 
1. Find the Inherit the Earth folder in the Windows Start menu and select the 

Uninstall Inherit the Earth icon. This will start the uninstall program.  
 
2. Confirm you want to uninstall the game. You can choose to keep the  

configuration and saved game files, or you can have those deleted along with the 
game program and its data files.  

 
The uninstall will not be complete until you restart your system. You will be 
given that option before the uninstall program exits. 
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BEST PRACTICES 

3.14 Understanding patches, upgrades, versions and installing them 

Patches 

A patch (sometimes called a "fix") is a quick-repair job for a piece of programming. 

It is also called a service patch, a fix to a program bug. A patch is an actual piece of 
object code that is inserted into (patched into) an executable program. Patches 
typically are available as downloads over the Internet. 

A patch is the immediate solution that is provided to users; it can sometimes be 
downloaded from the software maker's Web site. 

system security patches 

server operating systems are primarily software based and are constantly being 
upgraded. Some of the software upgrades become available in the form of "patches" 
or small sets of software code. Security updates, or patches, need to be kept current. 

Upgrades 
 
A new version of a software or hardware product designed to replace an older version 
of the same product. Typically, software companies sell upgrades at a discount to 
prevent users from switching to other products. In most cases, you must prove you 
own an older version of the product to qualify for the upgrade price. In addition, the 
installation routines for upgrades often check to make sure that an older version is 
already installed on your computer; if not, you cannot install the upgrade. 

 
Versions 

Version is a state of an object or concept that varies from its previous state or 
condition. The term "version" is usually used in the context of computer software, in 
which the version of the software product changes with each modification in the 
software. Revision control is very useful for keeping track of different versions of 
information. 

3.15 General Security Concepts 

Computer security is a field of computer science concerned with the control of risks 
related to computer use. 

A password is a form of secret authentication data that is used to control access to a 
resource. The password is kept secret from those not allowed access, and those 
wishing to gain access are tested on whether or not they know the password and are 
granted or denied access accordingly. 

 

http://www.webopedia.com/TERM/p/program.html
http://www.webopedia.com/TERM/p/bug.html
http://www.webopedia.com/TERM/p/object_code.html
http://www.webopedia.com/TERM/p/download.html
http://www.webopedia.com/TERM/u/software.html
http://www.webopedia.com/TERM/u/hardware.html
http://www.webopedia.com/TERM/u/user.html
http://www.webopedia.com/TERM/u/computer.html
http://en.wikipedia.org/wiki/Computer_software
http://en.wikipedia.org/wiki/Revision_control
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Criticality of Password 

Password Security: Appropriate security and access controls based on the criticality 
of the system must be implemented and enforced to protect passwords that provide 
access to network resources. The following password strength rules are minimum 
requirements that must be followed by the user and enforced as far as possible by the 
system for any system active in the network in which accounts are provided. 

Encryption of Passwords: All passwords stored on a system must be encrypted. 

Forming New Passwords 

The following format restrictions are designed to help prevent passwords from being 
compromised. 

• Passwords must be a minimum of 8 characters.  
• Passwords must incorporate at least 3 of the following: upper case, lower case, 

numbers, and special characters (i.e. punctuation and symbols).  
• Passwords must not include any portion of the user's logon name or the user's 

first or last name or a word commonly found in any dictionary.  

• Password expiration: Passwords must be set to expire at least once per year.  

• Reuse of old Passwords: Users must be prevented from reusing their 
previous three passwords.  

Account Protection 

Account locking: The system must be set to deny access for a period of time 
consistent with the criticality of the system after 6 consecutive, unsuccessful logon 
attempts.  

Access: To prevent unauthorized access to System resources, changes in role or 
separation from the  must result in corresponding changes or deletion of information 
technology account access privileges. It is the responsibility of the unit to which the 
person reported to ensure that these changes occur.  

Operating Systems/Network Applications: System administrators are responsible 
for installing operating system and network applications updates of all manufacturer 
recommended security patches and for turning off all identified unnecessary services.  

Virus Protection: It is the responsibility of each unit to ensure that the virus 
protection software is installed and enabled on unit computers. Unit computers must 
be set to update virus definitions daily. A scan of local storage must be scheduled to 
run minimally weekly.  

Physical Security: The physical security of the  resources (including, but not limited 
to the facility, equipment, software and information) must be maintained. Individuals 
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and units are responsible for implementing security measures for the resources within 
their purview, commensurate with the criticality of each information technology 
resource.  

3.16 Disk Cleanup 
 
The Disk Cleanup tool helps you free up space on your hard disk by searching your 
disk for files that you can safely delete. You can choose to delete some or all of the 
files. Use Disk Cleanup to perform any of the following tasks to free up space on 
your hard disk:  
 

1. Remove temporary Internet files. 
2. Remove downloaded program files. For example, ActiveX controls and Java 

applets that are downloaded from the Internet. 
3. Empty the Recycle Bin. 
4. Remove Windows temporary files. 
5. Remove optional Windows components that you are not using. 
6. Remove installed programs that you no longer use. 

 
 

You can start Disk Cleanup, by doing any of the following:  
 
1. Click Start, and then click Run. In the Open box, type cleanmgr, and then click 

OK.  
2. Click Start, point to All Programs, point to Accessories, point to System Tools, 

and then click Disk Cleanup.  
3. In Windows Explorer or My Computer, right-click the disk in which you want to 

free up space, click Properties, click the General tab, and then click Disk 
Cleanup. 

 
Remove Files Stored on Your Hard Disk 

1. To remove files stored on your hard disk that you no longer use, follow these 
steps: 

2. Click Start, and then click My Computer. 
3. Right-click the disk in which you want to free up space, and then click 

Properties. 
4. Click the General tab, and then click Disk Cleanup. 
5. Click the Disk Cleanup tab (if it is not already selected), click to select the check 

boxes next to the files that you want to remove, and then click OK. 
6. Click Yes to the proceed with this action, and then click OK. 

Remove Windows Components 

To remove Windows components that you are not using, follow these steps:  

1. Click Start, and then click My Computer. 
2. Right-click the disk in which you want to free up space, and then click 

Properties. 
3. Click the General tab, and then click Disk Cleanup. 
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4. Click the More Options tab, and then under Windows components, click Clean 
up.  
 
The Windows Components Wizard starts. 

5. In the Components list, click to clear the check box next to the component(s) that 
you want to remove.  

6. A shaded check box next to a component indicates that only some of its 
subcomponents are installed.  
 
If you want to remove a subcomponent, click Details, click to clear the check box 
next to the subcomponent(s) that you want to remove, and then click OK. 

7. Click Next. 
8. In the Completing the Windows Components Wizard page, click Finish. 
9. Click OK, click Yes to proceed with this action, and then click OK. 

Remove Installed Programs 
To remove programs that you no longer use, follow these steps:  
 
1. Click Start, and then click My Computer. 
2. Right-click the disk in which you want to free up space, and then click 

Properties. 
3. Click the General tab, and then click Disk Cleanup. 
4. Click the More Options tab, and then under Installed programs, click Clean up.  

 
The Add or Remove Programs dialog box is displayed. 

5. In the Currently installed programs list, click the program that you want to 
remove, and then click Remove (or Change/Remove). 

6. If you receive a prompt to confirm the removal of the program, click Yes. 
7. Repeat step 5 and 6 to remove other programs that you no longer use, and then 

click Close.  
8. Click OK, click Yes to proceed with this action, and then click OK. 

Remove Restore Points 
To remove all restore points except the most recent restore point, follow these steps:  
 
1. Click Start, and then click My Computer. 
2. Right-click the disk in which you want to free up space, and then click 

Properties. 
3. Click the General tab, and then click Disk Cleanup. 
4. Click the More Options tab, and then under System Restore, click Clean up. 
5. Click Yes to remove all but the most recent restore point. 
6. Click OK, click Yes to proceed with this action, and then click OK. 

 
3.17 Regular Updating of Antivirus Software 

There are three steps to complete protection from menacing computer viruses: 

1. Get a good virus protection program.  
2. Install the software; set it to run in the background and keep it on.  
3. Update the your anti-virus software on a regular basis.  
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All three of these steps must be followed to have a good virus protection program in 
place. 

Step 1: Get Virus Protection 

You can purchase the good Antivirus program at almost any computer or electronics 
store. Many bookstores and department stores also carry software today. You can also 
download an anti-virus program directly from the Internet, so you don't even have to 
leave home. 

Step 2: Installation 

When you install your anti-virus program, you will have various options to choose. 
Set the program to automatically scan all files. If your program is already installed, 
just start the program and find the area where you can check to make sure the 
program is set to scan automatically. 

Step 3: Update Regularly 

Unfortunately, most people stop after the first two steps. If you have installed a virus 
protection program and set it to run in the background, constantly checking for 
viruses, you may feel that you deserve a certain amount of comfort. You may even 
think you are completely covered and that no viruses can hurt your computer. 
However, you must be aware that the third step is an essential one. 

You must update your virus protection program on a regular basis to keep it up to 
date. Most virus programs consist of two main parts: heuristic scanning, which 
searches for virus-type behavior; and a virus pattern database, sometimes called virus 
signature files, that identifies specific, known viruses. The database is the part that 
needs to be updated. More than 250 new viruses are detected each month. Companies 
that manufacture anti-virus software incorporate the detection processes for the new 
viruses almost as quickly as they are detected. However, the anti-virus software on 
your computer will not detect or eliminate new viruses or variants until you download 
the new anti-virus update. 

How you update your anti-virus software depends on the type and version of the 
software that you own. Start your anti-virus program. In Windows, click on the Start 
button, choose Programs and look for the anti-virus program.  

Use Automatic Update 

Most of the newer versions of these anti-virus programs have an automatic update 
feature. To use this feature, just connect to the Internet, start the anti-virus program 
and click on the Update button. The Update process is completely automated. The 
problem is that the automatic update does not always work. 

If the update doesn't work, or you don't have an automatic update feature, you will 
have to go to the website of the manufacturer to find the latest updates. Find the latest 
update for the operating system that you are using and download it to your computer. 
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After you download the update, you must install it by finding the file and double-
clicking on it.  

Help with Large Downloads 

An important thing to note here is that the virus update files can be very large. If your 
memory cache is set too low, you will get through only a part of the download. Your 
browser will come up with some cryptic message like "Server Reset", and the 
download will stop. Most people then retry the download again and the same thing 
happens again. Three or four frustrating hours later the download still has not 
completed. 

There is an easy fix for this. If you are using Internet Explorer, on the Tools menu 
click on Internet Options. Then on the General tab, click on Settings. Move the slider 
to the right to create a larger cache. If you are using Netscape Navigator, Go to Edit, 
then Preferences. Choose Advanced, then Cache. Increase the size of the memory 
cache. When I downloaded a recent update, the size of the file was 2513 KB. I 
increased the memory cache size to 3000KB and the download worked fine. 

If these instructions don't work with the particular version of browser that you have, 
go to the help menu and search for the word Cache to find out how to increase the 
size of the cache.  

Staying Virus-Free 

Many anti-virus programs offer free updates, but some will charge you a slight fee for 
the updates. Also, if you have an older version of an anti-virus program, you may 
have to pay to upgrade to a more current version in order to be fully protected from 
the many new viruses that appear every day. Consider the investment that you make 
in anti-virus software as an insurance expense. In today's world, it is insurance that 
you don't want to be without. 

After you update your virus protection program, you will want to scan your hard disk 
to make sure that you haven't picked up any new viruses since your last update. 
Remember that many viruses are date triggered. They can exist in your computer 
system long before they do any damage. 

If the virus scan finds any viruses, it will prompt you and then remove the virus. This 
is a quick and easy process, which requires very little knowledge or intervention on 
the part of the end-user. In many cases, the virus protection program will remove the 
virus and repair your files without any data loss. However, it is always better to be 
safe than sorry, so be sure to backup any important files on a regular basis. 

3.18 Scandisk 

A DOS and Windows utility that finds different types of errors on hard disks and is 
able to correct some of them. In DOS, you run ScanDisk by entering scandisk at the 
prompt and pressing the Enter key. In Windows 95, you can run ScanDisk by 
selecting Start->Programs->Accessories->System Tools->ScanDisk 

http://www.webopedia.com/TERM/S/DOS.html
http://www.webopedia.com/TERM/S/Windows.html
http://www.webopedia.com/TERM/S/utility.html
http://www.webopedia.com/TERM/S/hard_disk.html
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Among other things, ScanDisk checks the disk platters for defects and also looks for 
lost clusters that are sometimes created when a program aborts. 

SCANDISK or ScanDisk is a command in MS-DOS and Microsoft Windows systems 
which marks bad clusters. It was introduced in MS-DOS version 6.2. Previous 
versions of MS-DOS supplied only the simpler, purely text-based program CHKDSK. 
In Windows 95 onwards, SCANDISK also had a graphical user interface. The disk 
scanning utility under Windows NT, Windows 2000 and Windows XP is also called 
CHKDSK (even though it is different from the MS-DOS CHKDSK) and has the 
capability of doing a surface scan. 

Scandisk will check and correct for bad blocks or disk errors on  any writable media, 
such as a hard, zip, floppy, or Super disk. 
 
To use scandisk: 
1.   Insert disk to be scanned into the drive. 
2.   Click on "My Computer." 
3.   Use the *rightmost* mouse button to click on "A drive," (if disk is a floppy,   
      otherwise choose the drive as appropriate). 
4.   (Left) click on "Properties." 
5.   Click on the "Tools" tab. 
6.   Click the error checking button "check now." 
7.   Select both the "Automatically fix filesystem errors" and "Scan for and attempt  
      recovery of bad sectors" boxes. 
8.   Click "Start." 

 
 

Scandisk will check your floppy or other disk for errors, and fix  them if possible. 

3.19 Backup Utility 

Backup in computer refers to the copying of data for the purpose of having an 
additional copy of an original source. If the original data is damaged or lost, the data 
may be copied back from that source, a process which is known as Data recovery or 
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Restore. The "data" may be either data as such, or stored program code, both of which 
are treated the same by the backup software.  

Use of data backups 

Computer backups are useful primarily for two purposes, the first and most obvious is 
to restore a computer to an operational state following a disaster also called disaster 
recovery. This includes loss of a hard disk or the file system becoming so badly 
corrupted it cannot be read. The second use, often overlooked but probably more 
common, is to facilitate the recovery of a single file or set of files when they are 
accidentally deleted or corrupted by the user or a program. 

Types of backups 

There are primarily three different types of backup - full, incremental, and 
differential. 

A full backup is simply the backing up of all the files on the system. This may or may 
not included the file allocation tables, partition structure and boot sectors, depending 
on whether the backup is a drive image or just a file copy. 

An incremental backup only backs up the files that have changed since the most 
recent backup (either full or incremental). The advantage of this is quicker backup 
times, as only files changed since the last backup (full or incremental) need to be 
saved. 

A differential backup is a cumulative backup of all changes made since the last full or 
incremental backup. The advantage to this is the quicker recovery time, requiring 
only a full backup + incrementals and the latest differential backup to restore the 
system.  

Backup Tools 

During the period 1975–95, most personal/home computer users associated backup 
mostly with copying floppy disks.  

However, the recent drop in hard disk prices and its number one position as the most 
reliable re-write-able media make it one of the most practical backup media. 

A CD-R can be used as an alternative backup device. One advantage of CDs is that 
they can hold 700 MB of data on it. They can also be restored on any machine with a 
CD-ROM drive. CDs may all look the same, but there are different file formats for 
different applications. 

The option of backup online via the internet to a remote location is also available, 
thus eliminating the worse case scenarios, such as someone's study burning down to 
the ground along with the computer, its hard drive, and any on-site backup disks.  
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Backup Procedure 

Windows XP makes this task especially easy by giving every user account its own 
personal profile, which consists of a set of subfolders in the Documents and Settings 
folder. If you have personal data stored elsewhere, consider moving it into the My 
Documents folder to make backing up easier.  

Open Windows XP Backup 

Windows XP includes its own backup program, although you may need to do some 
digging to find it. You can also take your pick of third-party programs (listed at the 
end of this column) that add bells and whistles you won't find in the basic Windows 
XP Backup utility. 

How to Install Backup in Windows XP Home Edition. 

To start Backup: 

1.   Click Start, point to All Programs, point to Accessories, point to System Tools, 
and then click Backup to start the wizard. 

2.   Click Next to skip past the opening page, choose Back up files and settings from 
the second page, and then click Next. You should see the page shown in the 
following figure which represents your first decision point.  

 

 

Decide What to Back Up 

If you know that you have data files stored outside your profile, click Let me choose 
what to back up. This option takes you to the Items to Back Up page shown in the 
following Figure 
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Select the My Documents check box to back up all the files in your personal profile, 
and then browse the My Computer hierarchy to select the additional files you need 
to back up. If some of your files are on a shared network drive, open the My 
Network Places folder and select those folders. 

This option also comes in handy if you have some files you now you don't want to 
back up. For instance, I have more than 20 GB of music files in the My Music folder. 
To keep my data file backup to a reasonable size, I click the check box next to the My 
Music folder. This clears the check box from all the files and subfolders in My Music. 

Decide Where to Store Your Backup Files 

Windows asks you to specify a backup location. If you're one of those exceedingly 
rare individuals with access to a backup tape, the Backup utility gives you a choice of 
options in the Select a backup type box. No tape drive? No problem. Backup assumes 
you're going to save everything in a single file; you just have to choose a location for 
that file and give it a name. 

By default, Backup proposes saving everything to your floppy drive (drive A). 
Although that might have made sense 10 years ago, it's hardly a rational choice today. 
You'd need dozens, perhaps hundreds of floppy disks to store even a modest 
collection of data files, especially if you collect digital music or photos. 

After you've chosen a backup location, enter a descriptive name for the file, click 
Next to display the wizard's final page, as shown in the following Figure, and then 
click Finish to begin backing up immediately. 
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Set a Schedule—and Stick to It 
If you're disciplined enough, you can repeat the above steps once each week and 
perform regular backups when you're ready. If you'd rather not count on remembering 
to perform this crucial task, however, set up an automatic backup schedule for 
Windows. When you get to the final page of the Backup Wizard (see Figure 3 above), 
don't click Finish. Instead, click the Advanced button, and click Next to open the 
When to Back Up page. Choose Later, and then click Set Schedule to open the 
Schedule Job dialog box shown in Figure 4. 
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This example shows the settings for a weekly backup on Friday afternoon—a good 
way to make sure your week's work is protected. But you can set almost any schedule 
you want by poking around in the extensive set of options available in this dialog box. 
After you click OK to save your changes, Windows XP runs the backup 
automatically. Just remember to leave your computer turned on. 

All in all, you can count on backing up 5 GB of data in as little as 10 minutes. And 
you don't need to worry about shutting down running programs, either—thanks to a 
feature called volume shadow copy, the Backup utility can safely create a copy of 
any file, even if it's currently in use.  
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TROUBLESHOOTING 

3.20 Troubleshooting Fundamentals 

Troubleshooting is a form of problem solving. It is the systematic search for the 
source of a problem so that it can be solved. Troubleshooting is used in many fields 
such as system administration and electronics. Normally a process of elimination is 
used to isolate possible causes of problems.Usually troubleshooting is applied to 
something that has suddenly stopped working, so the first focus, or concentration of 
attention, should be on what has changed. However, care must be used to not jump to 
false conclusions of causality - correlation does not always mean cause. 

• Strategies used to define and solve problems encountered while using information 
technology tools. 
 

• Systematic approach to locating the cause of a fault in system. 
 

• Troubleshooting is a form of problem solving. It is the systematic search for the 
source of a problem so that it can be solved. Troubleshooting is used in many 
fields such as system administration and electronics. Normally a process of 
elimination is used to isolate possible causes of problems.  

3.21 Troubleshooting Tools 

The following troubleshooters are available in Windows. You can start a 
troubleshooter by clicking the name in the left column of the table. 

Troubleshooter Identifies and resolves problems related to: 
System setup Installing and setting up Windows. 
Startup/Shutdown Starting and shutting down your computer. 

Display 
Video cards and video adapters, including your computer screen, 
outdated or incompatible video drivers, and incorrect settings for your 
video hardware. 

Home networking Setup, Internet connections, sharing files and printers. 

Hardware 

Disk drives (including CD-ROM and DVD drives), game controllers, 
input devices (such as keyboards, mice, cameras, scanners, and infrared 
devices), network adapters, USB devices, modems, and sound cards. 
Also see the more specific hardware device troubleshooters below. 

Multimedia and 
games 

Games and other multimedia programs, DirectX drivers, USB devices, 
digital video discs (DVDs), sound, joysticks, and related issues.  

Digital Video Discs 
(DVDs) DVD drives and decoders. 

Input Devices Keyboards, mouse and trackball devices, cameras, scanners, and 
infrared devices. 

Drives and Network 
Adapters 

Hard discs, floppy discs, CD-ROM and DVD drives, network cards, 
tape drives, backup programs. 

USB USB connectors and peripherals. 
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Sound Sound and sound cards. 
Modem Modem connections, setup, configuration, and detection. 
Internet connection 
sharing Connecting and logging on to your Internet service provider (ISP). 

Internet Explorer Browsing the Web, downloading files, saving your favorites, using IE 
toolbars, or printing Web pages. 

Outlook Express 
(Messaging) Outlook Express and Windows Messenger Service. 

File and Print 
Sharing 

Sharing files and printers between computers, connecting to other 
computers in a network, installing network adapters, logging on. 

Printing Printer installation and connection, printer drivers, print quality, printer 
speed, and fonts. 

 
Some Operating System offers tools to help you troubleshoot problems with starting 
your computer and recovering from disasters. Some of the most useful tools are 
detailed in this section. 

 
1. Startup and Recovery Troubleshooting Tools 

 
Tool Description How to Start 
Safe Mode A startup environment that limits the device 

drivers and system services that load for 
troubleshooting problems with starting and 
running Windows 2000. 

Windows 2000 Advanced 
Options Menu at system 
startup 

Recovery 
Console 

A command-line startup environment that 
allows the system administrator access to the 
hard disk of computers running Windows 2000 
for basic troubleshooting and system 
maintenance. 

From Repair option of Setup 
or, if manually installed, from 
Operating System menu at 
startup 

Emergency 
Repair 
Process  

A process that can recover from problems such 
as damaged or deleted operating system files or 
a corrupted system volume boot sector. 

From Repair option of Setup 

 
2. Maintenance and Update Troubleshooting Tools 

 
Tool Overview Location 
Check Disk 
(Chkdsk.exe) 

Scans for and repairs physical problems, such as 
bad blocks, as well as logical structure errors, 
such as lost clusters, cross-linked files, or 
directory errors, on volumes on the hard disk. 

%systemroot%\System32

Disk 
Defragmenter  
 

Rearranges files, folders, programs, and unused 
space on the hard disk to optimize disk 
performance. 

%systemroot%\System32
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Table 31.8 Device and Driver Troubleshooting Tools 
Tool Overview Location 
System File 
Checker (Sfc.exe) 

As part of Windows File Protection, scans 
protected system files and replaces files 
overwritten with correct versions provided by 
Microsoft. 

%systemroot%\System32

Driver Verifier 
(Verifier.exe) 

Runs a series of checks in the Windows 2000 
kernel to help readily expose errors in kernel 
mode drivers. 

%systemroot%\System32

 
3. Applications Troubleshooting Tools 

 
Tool Overview Location 
System Information 
(Msinfo32.exe) 

Collects and displays system 
configuration information about 
hardware, system components, and the 
software environment. 

Program Files\Common 
Files\Microsoft Shared\Msinfo 

Registry Editor 
(Regedt32.exe) 

An advanced editing tool for adding 
and changing settings and creating 
subkeys in the registry. 

%systemroot%\System32 

 
4. Networking Troubleshooting Tools 

 
Tool Overview Location 
Network 
Diagnostics 
(Netdiag.exe) 

Helps isolate networking and 
connectivity problems by performing a 
series of tests to determine the state of 
your network client and whether it is 
functional. 

Support Tools on the 
Windows 2000 operating 
system CD 

IP Configuration 
(Ipconfig.exe) 

Displays the current configuration of the 
installed IP stack on a networked 
computer using TCP/IP. 

%systemroot%\System32 

Path Ping 
(Pathping.exe) 

A route tracing tool that sends packets to 
each router, and then computes results 
based on the packets returned from each 
hop. 
 

%systemroot%\System32 

 
3.22 Troubleshooting Viruses  
 

There are hundreds of viruses that can effect a computer. New ones are created every 
day. Virus hoaxes are also introduced daily. Hoaxes look like viruses, but don't act 
like them 
 
Commercial software is available that will warn you if you are trying to copy an 
infected file to your computer - regardless of whether the file comes from an e-mail 
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enclosure, a floppy disk or CD, or via the Internet. This software may also remove a 
virus from your computer if it finds one. 
 
There are three very important steps to protecting your computer from viruses: Install 
an antivirus software program and keep up-to-date with the latest virus definitions. 
Make sure your operating system is fully patched and up-to-date. Do not open e-mail 
enclosures unless you are expecting receipt of them. Some viruses propagate 
themselves by using the address book found on a computer to e-mail itself to other 
recipients. This type of  e-mail is considered a form of spam, as it may appear to be 
from someone you know. Many people automatically trust these messages and open 
the attached file. Just because it appears to be from someone you know, doesn’t mean 
they intentionally sent the file to you. If you are unsure, contact the person and ask if 
they sent you something prior to opening it.  

 
Troubleshooting - Disinfecting the computer 
 
 If the virus activity returns to the computer, the service will be blocked again.  
 
First Option (cleaning option) 
 
Disinfect: Disinfect the computer of viruses/worms/problems using an Antivirus 
program with updated virus definitions AND provide the list of cleaned viruses as 
proof to CNS that viruses has been cleaned from the computer.   
 
   
Second Option (cleaning option) 
 
BackUp: Backup all important data and files such as homework, essays, documents, 
pictures, etc. onto a CD or other storage device. 
   
Format: re-format or re-initialize the computer's system drive (usually c: drive) to 
erase everything and reinstall the operating system.  Everything will be erased 
including the virus problem, so make sure there are appropriate support materials to 
reinstall everything back on the computer, reinstall computer operating systems or  
install software. 
   
Antivirus Program: Make sure Antivirus is loaded and has up to date virus 
definitions  
 
If the steps were not done correctly, or the virus activity returns (some viruses may 
come back) to the computer, the service will be blocked again.  The Second Option is 
the only guaranteed way of removing and cleaning virus problems. 

 
3.23 Problem that keep a computer from starting boot  
 

To load the first piece of software that starts a computer. Because the operating 
system is essential for running all other programs, it is usually the first piece of 
software loaded during the boot process.  
 

http://www.webopedia.com/TERM/b/load.html
http://www.webopedia.com/TERM/b/software.html
http://www.webopedia.com/TERM/b/operating_system.html
http://www.webopedia.com/TERM/b/operating_system.html
http://www.webopedia.com/TERM/b/run.html
http://www.webopedia.com/TERM/b/program.html
http://www.webopedia.com/TERM/b/process.html
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Boot is short for bootstrap, which in olden days was a strap attached to the top of your 
boot that you could pull to help get your boot on. Hence, the expression "pull oneself 
up by the bootstraps." Similarly, bootstrap utilities help the computer get started. if it 
damaged, the system does not start. 

 
Short for bootstrap, the starting-up of a computer, which involves loading the 
operating system and other basic software. A cold boot is when you turn the computer 
on from an off position. A warm boot is when you reset a computer that is already on. 

 
Power-on self test (POST) 
 
Abbreviated POST, a diagnostic testing sequence run by a computer’s BIOS as the 
computer’s power is initially turned on. The POST will determine if the computer’s 
RAM, disk drives, peripheral devices and other hardware components are properly 
working. If the diagnostic determines that everything is in working order, the 
computer will continue to boot. 

 
Boot loader 
 
Most computer systems can only execute code found in the memory (ROM or RAM); 
modern operating systems are mostly stored on hard disks (occasionally Live CDs, 
USB flash drives, and the like). Just after a computer has been turned on, it doesn't 
have an operating system in memory. The computer's hardware alone cannot perform 
complicated actions of the operating system, such as loading a program from disk; to 
load the operating system into memory, one appears to need to have an operating 
system already installed. 
 
Early programmable computers had toggle switches on the front panel to allow the 
operator to place the bootloader into the program store before starting the CPU. This 
would then read the operating system in from an outside storage medium such as 
paper tape, punched card, or an old fixed head disk drive. 

 
3.24 Troubleshooting Operating System  

 
Disk defragmentation 
 
The process of rewriting parts of a file to contiguous sectors on a hard disk to increase 
the speed of access and retrieval. When files are updated, the computer tends to save 
these updates on the largest continuous space on the hard disk, which is often on a 
different sector than the other parts of the file. When files are thus fragmented, the 
computer must search the hard disk each time the file is opened to find all of the file's 
parts, which slows down response time. 

 
System Restore 
 
A tool that tracks changes to your computer and creates a restore point when it detects 
the beginning of a change. You can use the System Restore Wizard to select a restore 
point to restore your computer to an earlier state when your computer was functioning 
the way you like. 

 

http://www.webopedia.com/TERM/b/utility.html
http://www.webopedia.com/TERM/b/cold_boot.html
http://www.webopedia.com/TERM/b/warm_boot.html
http://www.webopedia.com/TERM/p/BIOS.html
http://www.webopedia.com/TERM/p/RAM.html
http://www.webopedia.com/TERM/p/disk_drive.html
http://www.webopedia.com/TERM/p/peripheral_device.html
http://www.webopedia.com/TERM/p/hardware.html
http://www.webopedia.com/TERM/p/boot.html
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Read-only_memory
http://en.wikipedia.org/wiki/Random_Access_Memory
http://en.wikipedia.org/wiki/Hard_disk
http://en.wikipedia.org/wiki/LiveCD
http://en.wikipedia.org/wiki/USB_flash_drive
http://en.wikipedia.org/wiki/Computer_hardware
http://en.wikipedia.org/wiki/Switch
http://en.wikipedia.org/wiki/Central_processing_unit
http://en.wikipedia.org/wiki/Paper_tape
http://en.wikipedia.org/wiki/Disk_drive
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Backup  
 
A collection of files, folders, and other data that has been backed up and stored in a 
file or on one or more tapes. 
 
Disk Cleanup 
 
Disk Cleanup helps free up space on your hard drive. Disk Cleanup searches your 
drive, and then shows you temporary files, Internet cache files, and unnecessary 
program files that you can safely delete. You can direct Disk Cleanup to delete some 
or all of those files. 

 
Troubleshooting Scheduled Tasks 
 
If a scheduled task does not run when you expect it to, right-click the task, and then 
click Properties. On the Task tab, verify that the Enabled check box is selected. On 
the Schedule tab, verify that the schedule is set correctly. 

 
3.25 Problems after a Computer Boots 
 

After successfully completion of Boot, sometimes the system encounters some 
problems. Some of them are listed below: 
 
System speed slow: It is mostly found problem after a system boot. When you open 
any application, it takes to much time to open/close 
 
Reason: There may be too much application are opened which consumes majority of 
RAM. System may be virus infected. Hard disk may be filled up with temporary/junk 
files.  
  
Solution: It requires to increase RAM OR disinfect the system with the latest Anti-
virus program. The hard disk may require disk cleanup procedure which removes the 
junk files from the system. 

 
 System hang: System does not reply any request by the user. 
  
 Reason: The system may be virus infected OR any corrupted .exe file is in run state. 
  

Solution: Latest Anti-virus must be used to remove the virus. Using Task manager, 
the corrupted application should be stopped. 

 
     
 

--------*****--------- 
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